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Installation and Quick Start Guide

Installation

Please refer to <CG-500 Quick Guide> to install the software.

Quick Start Guide

After successfully installing the software, double-click on the CG-500 icon to launch the program.

. A
L= (A4

CG-500"  VxMvMaker
Player

Please Note:

1. Please ensure that the dongle is properly connected to the computer. When using
CG-500 the dongle must be connected at all times, otherwise the software will not
function correctly.

2. When EDIUS is running, it is not possible to launch CG-500 independently.

3. Itis not possible to launch multiple CG-500 at the same time.
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Overview of functions

Start Project Screen

Open CG-500 independently, Start Project screen will appear.

(£6:500]

Frame Rate

Frame Rate

25fps

0001 0002
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Functions:
1) History Project
Show latest project.
2) Layout List
Show layout list of the selected history project.
3) Buttons
New Project: click the button to open System Format Select screen
Browse Project: allows you to browse and open local project
Open Project: allows you to open the selected history project
Close: exit CG-500 software

Select Format Screen

Click on the “New Project” button, System Format Select screen will appear.

Resolution

BitCount
rimetry
ect Ratio

Frame Rate

Title Qluality

+ Lse Default

General Deflicker

Small text Deflicker

Ower striking Factor

= | B O

Use current format in nex

Three functions can be performed:
1) Choosing a format.
For example, PAL D1 50i or PAL Full HD 1080/50i 16:9.

Note: if one format is frequently used it can be set as the default format.

2) Add custom format

Datavideo Technologies Co., Ltd.
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Choose “Custom” format.

i

1*1080 —

solution 56500 |- |08
BitCount
Colorimetry TU-R 709
ct Ratio 16:9
Frame Rate

Y

Field Order Upper First «

3) Set Title parameters.

Title Quality

Use Default * Custom
General Deflicker Mormal
Small text Deflicker Mormal
Ower striking Factar

Save To Default

Custom parameters can be set by clicking on "Custom", setting parameters, and then clicking
on “Save as Default Parameters”.
Note: If, once in CG-500, the format needs to be changed, you can:

1. Use the shortcut Ctrl+Shift+P

2. Click on the “Document Settings” button. Once the format has been chosen,

click on “OK” to proceed.

Datavideo Technologies Co., Ltd. 11



Untitled

Untitled

The Main Interface screen is divided into the following parts:

Menu Bar - this is the main tool bar

Layout List- lists all layouts

R

The Menu Bar

File Menu

Edit Screen - allows you to directly edit objects and text

Timeline Window - shows duration items in every layout page

Properties Window - allows you to edit the properties of objects and text
Status Bar - provides basic layout information and interface tools

Bmp Grad

=S

Undo: undoes action

Redo: restores undone action

Start Project

New Project: creates new pro

ject

Save: saves project

Save As: saves project as “new name”

Import Layout

— Export Layout

E Open Project: opens existing project

Add Layout

Datavideo Technologies Co., Ltd.
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Insert Layout

m Remove Layout

Document  Settings: set

settings

project

Edit Menu

File |Edit

Copy Paste
Cut Delete
Align Align Range

Screen Arrangement

Move Level: adjust object level

Group: creates a group of objects

Ungroup: separates a group of
objects

Boolean: Boolean operations

Object Menu

File Edit |Object| Option Scroll

=R

n Select: choose an item E Shape: create object of certain
shape
“ Line: create lines Bezier: create Bezier curves
Text: create text Morph Text: create
multidimensional text
Curve Text: create curved text o Flag: create flag object
E Image: create image Clock: create clock
Title Plugin: Create Plugln object
Options Menu
File Edit Object |Option! Scroll
OOHE (B8 |+ Grid Color
Datavideo Technologies Co., Ltd. 13




Show/Hide Ruler

Show/Hide Safe Area

Show/Hide Crossline

m Show/Hide Grid

Background: choose background

- System Options: choose background and other settings

Edit Object Option |Scroll

[ | & | =]

Still: set as still Roll up

Crawl left Crawl right

Add One: adds one screen Add Half: adds half a screen

Delete Half: deletes half a
screen

Show/Hide Roll/Crawl Line Go to screen: quickly go to

.

Delete One: deletes one screen

the desired roll/crawl screen

File Edit |Effect! Option Scroll

R & O e (O

Select Translate: move the object

Rotate: rotate the object Scale: adjust size

Transparency Pivot: Enable Pivot Setting Tool

L1
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Create Freehand Path Reset 3DView

4

View 3D horion Y View Camera Output Window
=

This menu will appear when shifting to Effect Mode (shortcut F10).

Text Editor Toolbar

The Text Editor Toolbar allows you to set text parameters:
Font
Italics

B Bold

[ u | Underline

Height

Width

Lock: lock height-width ratio

Align Left

Align Center

Align Right

Line Range

Character Range

Arrange: present text horizontally or vertically

Render: apply effects to whole text or to individual characters
B3 Show/Hide Text Editor advanced functions

Enter left-right

Enter right-left

Enter top-down

Enter bottom-up

Font Mode
A= Fill Mode

i Set vertical shear effect

Set horizontal shear effect

LI Small Caps
Unconstraint

Constraint

]
Offset punctuation for vertical text

A . .
Donot offset punctuation for vertical text
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Layout List

Use the Layout List to quickly edit several titles.
Frequent operations are:

View: click on a Layout to make it appear on the
Edit Screen

Add Layout: right click on a layout and choose
“Add”

Delete Layout: rightclick on layout and choose
“Delete”

Layout List right-click context menu:

Append

Pa ge U P

PageDown
Home

End

Append: adds layout

Insert: inserts layout

Delete: deletes layout

Rename: changes layout name
Copy: copy layout

Cut: cut layout

Paste: paste layout

Move Up

Move Down

Move Top: move layout to front
Move Bottom: move layout to end
Prev Screen: show previous screen
Next Screen: show next screen
Head Screen: show first screen
Tail Screen: show final screen

Datavideo Technologies Co., Ltd.
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Graphics (still) Editing Mode

00:00:00:00

Right-click on the Edit Screen

1. The following context menu will appear

View Ruler

View Grid

View Safe Area
View Cross Line
Enable Guideline
Fit Window Size
Show Full Color
Show Alpha Only
Show Fill Color
nlv Paste

Save Layout to Image File

Datavideo Technologies Co., Ltd. 17



2. Object context menu

Make Group

Make Group

Ungroup
Move Up
Up(l) Ctrl + PageUp Move Down
Move Top
Top Ctrl + Home Move Bottom
Lock/Unlock
Visible/Invisible
Edit

Cut

Copy

Paste

Lock/Unlock L

fInvisible Shift +V

Delete

Paste To Group

Delete

Copy Shader Style

Paste Shader Style

Scale ShaderStyle Parameter
Boolean

Mix Option

Align Objects

Center Object Pivot
Mirror Vertical

Mirror Horizontal

Reset morph Text

Text Block

Save Object to Image File

Center Object Pivot Ctrl + M
Mirror Vertical

Mirror Horizontal

Text Block

The Control Panel is used to operate items placed in the timeline tracks. Functions from left

to right:

Fit Window
100 Actual Size
Qt Custom Size

Datavideo Technologies Co., Ltd. 18



“ Choice Head - move to the start of chosen track

“ Choice Tail - move to the end of chosen track

“ Play Start
“ Play

E Loop - continuously replay
CG Preview Play

- Show Full color
ﬂ Show Alpha Only
I! Show Fill Color

<ed
s Shift between 2D/3D Effect

Left Time Code: current play time
Right Time Code: total play time.

Effect Editing Screen

Press the “Effects Editing Screen” button (or type F10) to shift from the Graphics (Still) Editing

Screen. Here you can set object keyframes.

rofessional User /Interface

Adjusting screen angle:
a. Tochange angle, hold “Alt”, left click and drag mouse.
b. To reset angle, hold “Alt” and double click.
When using the blank function, right click for the following context menu:
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Show Alpha Only

Reset Current 3D View
View 3D Horizon

View Camera Output Window
View Ruler

View Grid

View Safe Area

View Cross Line

View Zoom

Show Full Color

Show Alpha Only
Show Fill Color

Save Layout as Picture

When using the displacement function, right click for the following context menu:

Translate Animation

Insert Translate Keyframe
Delete Translate Keyframe

Go to Previous/Head Keyframe
Go to Next/Tail Keyframe
Reset Translate

Smooth Vertex

Sharp Vertex

Speed Up

Slow Down

Speed Normal

Ease in out

Set Line With Prev Translate Keyframe
Set Line With Next Translate Keyframe
Invert All Translate Keyframe
Uniform All Translate Keyframe
Reset All Transform

Reset Translate

Reset Pivot

Reset Scale

Reset Rotate

Reset Alpha

Datavideo Technologies Co., Ltd.
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When using the pivot function, right click to see the following context menu:

Pivot (XYZ) Animate

Insert Pivot Keyframe
Delete Pivot Keyframe

Go to Previous/Head Keyframe
Go to Next/Tail Keyframe
Reset Pivot

Invert All Pivot Keyframe
Uniform All Pivot Keyframe
Reset All Transform

Reset Translate

Reset Pivot

Reset Scale

Reset Rotate

Reset Alpha

When using the scale function, right click to see the following context menu:

All Transform

Scale(XYZ) Animate

Insert Scale Keyframe
Delete Scale Keyframe

Go to Previous/Head Keyframe
Go to Next/Tail Keyframe
Reset Scale

X scale value

Y scale value

Z scale value

Invert All Scale Keyframe
Uniform All Scale Keyframe
Reset All Transform

Reset Translate

Reset Pivot

Reset Scale

Reset Rotate

Reset Alpha

Datavideo Technologies Co., Ltd.
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When using the rotate function, right click for the following context menu:

it All Transform

Rotate(XYZ) Animate

Insert Rotate Keyframe
Delete Rotate Keyframe

Go to Previous/Head Keyframe
Go to Next/Tail Keyframe
Reset Rotate

X rotate value

Y rotate value

Z rotate value

Invert All Rotate Keyframe
Uniform All Rotate Keyframe
Reset All Transform

Reset Translate

Reset Pivot

Reset Scale

Reset Rotate

Reset Alpha

When using the transparency function, right click for the following context menu:

Alpha Animate

Insert Alpha Keyframe
Delete Alpha Keyframe

Go to Previous/Head Keyframe
Go to Next/Tail Keyframe
Reset Alpha

Invert All Alpha Keyframe
Uniform All Alpha Keyframe
Reset All Transform

Reset Translate

Reset Pivot

Reset Scale

Reset Rotate

Reset Alpha

Datavideo Technologies Co., Ltd.
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Keyframe context menu

Reset Translate
Delete this Keyframe
Smooth Vertex
Sharp Vertex

Speed Up

Slow Down

Speed Normal

Ease in out

Easein out

Properties Window

Property Tab

Pasition

Rotation

The Properties Window has five
tabs: Property, Shader, Effect, Text
and Roll/Crawl and CG property.
Name/Describe: view selected
object and describe

Mix Style: select Mix Normal/Mix
Penetrate

Render as new layer

Position: view position, make
change

Rotate: view rotate angle, make
change.

Scale: view scale parameters, or
change value. Left-click on ,
changing toB&, scale XY change
simultaneously.

Shear: view shear value, or
change.

Pivot: view pivot position, or
make change.

[ElReset: reset selected value.
-il Reset: reset all. By
clicking on it will reset all values,
but doesn't affect values in sub
screen.

Sub Window: marked place in the
picture left.

If choosing different object, sub

Datavideo Technologies Co., Ltd.
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window will appear different
accordingly.

Set parameters by:

a. Clicking on the field and typing in the numbers

b. Dragging the cursor over the field

Shader Tab

ine

Frame

Shader preview

@l Shader Style drop-down list

Properties list: Face, Edge,

Shadow, Depth
Add

Insert

B pelete
Move Up
Move Down

< You can set specific parameters in the
properties list.

<> You can also use preset Shader templates

<> Set Dynamic Texture and Masking, found at
the lower half of the tab.

Datavideo Technologies Co., Ltd.
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Use the = button to remove Face, Edge, Shadow or Depth,

= Outline

Width| 14

¥  Shadow

Datavideo Technologies Co., Ltd.
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Effect Tab

Direction

Percent

1
o @ &3

L

Left to Right

e
Bl @ [E

ol = |5l &l

To the left: 3D Transform, 2D Pan

and Screen In/Out areas

M oo
E Reset

E Fold/Expand
B oeicee

B ..

Screen In/Out area

“ Choose In method

Stay

Choose Stay method
n Choose Out method

Add Effect

Delete Effect

(=

=8 Refresh

Show Text List

Setting screen In effect:

Datavideo Technologies Co., Ltd.
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EIfBel
Eifcel

Eflaci

O MER = E
Direction

Fercent

o] HESN =

| [iTH]
tch

r Dither

Dithe
EIFBE]

Use the same method to apply “Stay” and “Out” effects.

Datavideo Technologies Co., Ltd.
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Text Tab

Whole text Line by line text
il 18 CG

a-H [Eh ) 88

= | E

Edit text options:
Whole text Line by line text
Create new Open existing file

Save Save As

Find and Replace Create text

= Create line by line text Create single-line text
Replace All =all | Replace
Subtitle Setting E Font Style

Roll/Crawl text editor menu:
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tTitle

Cont-Title

Har. Ap

Set Heading: sets chosen text as heading

Set Content: sets chosen text as content

Select Heading: pick out headings

Select Content: pick out content

Heading-Content: sets space between heading and content
Content-Heading: sets space between content and heading
Content-Content: sets space between content and content
Apply Horizontally: applies horizontally

Apply Vertically: applies vertically

At the bottom of the tab you can see the list of texts that are in the Edit Screen.
Left-click to edit.

The text listin current layout

Director

Jian Wans

Froducer

Datavideo Technologies Co., Ltd.
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Roll/Crawl Tab

End Cut Out

T

Tail Pos

otal Time

Roll In: set role in method

Roll Out: set roll out method
Custom: set roll time

Loop: set loop time and count

Speed Down: reduce roll speed.
Liner: apply liner effect

Ruler: set ruler size

Full: restore liner to full screen

Roll Area:

Ruler: set roll limits

Full: set ruler to full screen
Left/Right/Top/Bottom: set roll
limits

Start/End Fade: set head/tail in/out
position

Mask: apply mask effect

Invert: apply invert effect

Blur: set blur parameters

Datavideo Technologies Co., Ltd.
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CG Property Tab

% B ¢

Text Crawler Object

Field Mapping option

- —
Source Field

Object Type: choose object type

ID Class: choose ID class

ID: show ID

Direction: choose roll/crawl method
Speed: choose roll/crawl speed
Interval: set interval

Head Fade Pixel: set head fade pixel
Tail Fade Pixel: set tail fade pixel
Effect Option: choose effect
method

Duration: change effect duration
Data Source: choose data source
Text File: browse text file

Edit: edit file

Invalid File: show invalid file

Loop Play

Loop Count: set loop count

Has play title text: enable “Has play
title text” to use head symbol and
tail symbol

Data Field Mapping Option:
use/unused source field and target
field

If choosing different data source, the tab will appear different accordingly.

CSV File

Set field counts and field symbol

Datavideo Technologies Co., Ltd.
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Jdld SOUlrce

Text File

ODBC Database
Set DNS, SQL and edit SQL

ODBC Database

00:00:00;00
-
Group

3D Transform

o HEADING

FTTL200

Move object up Move object down

Move object to top Move object to bottom

Move effect up Move effect down

Render as new layer Normal object/replaceable object

Show animation track only Show all tracks name

Enable 3D transform Lock object to prevent editing

= ©l

—. Set track as Visible/Invisible n Show/Hide object effect tracks
| 2
= =

Enable Timeline Auto snap Expand all tracks
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=0
Adjust the Timeline using the bar shown or right click on the timeline, then drag the cursor.
Click on the bar-button at the very left of the Timeline to open the Templates Library.

3D Transform and Dynamic Texture tracks:

=

Enable/Disable 3D Transform Keyframe points.

Go to previous Keyframe

Add/Remove Keyframe

Go to next Keyframe

Right click on an object track to see the context menu:

LT 1.0000.0) e

Rectangle
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Move Up

Move Down

Move Top

Move Bottom
Lock/Unlock
Visible/Invisible
Render as new layer
Rename

Edit

Set Object Duration
Cut effect

Copy effect

Paste effect

Delete effect

Copy 3D Transform
Paste 3D Transform
Reset 3D Transform
Copy All

Paste all

Reset to default

Set subtitle pause point

3DTransform

Right click on an effect track to see the context menu:

00:00:03:05

00:00:00:00 00:00:04;1

TTT 1.0000.(®
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W animation tra

Lock/Unlock
Enable/Disable

Cut effect

Copy effect

Paste effect

Overlay effect

Delete effect

Reset effect

Invert all keyframe
Uniform all keyframe
Set as Fade In point
Set as Fade Out point
Fade In/Out

Show animation track only

.[n] 00:00:00 00:00:0
b BRI ——————
TT 1.0000.0) i i

v Enable Area

Uniform Are

Reset Area

Enable area

Add area

Delete area

Play by character (In)
Play by character (Out)
Play by line (In)

Play by line (Out)
Play by text
Frequency value
Uniform area

Reset area

Text

-

¢ 3D Transform

Datavideo Technologies Co., Ltd.
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Modify
Fill Fit
Add
Insert
Cut
Copy

Modify ...

Fill Fit

Overlay
Paste
Delete
Set speed
Delete all
Select all

F:

ast(100)

torm...

Right click on an empty track in the Timeline to see the context menu:

W

Show Track Header

Child View
w Timeline Pointer

Timeline AL

Expand all Track

Foom Fit

Show/Hide track header

Show/Hide Aux child view

Show Timeline Pointer

Timeline Auto Snap

Expand all tracks

Zoom fit (you can also double click on the timeline)

HDO010 HDO11 HD012

Template Library options:

HDOO06 HDOoO7 HDoog HDO09

T — | [ 1]f==es

HDO013 HDO14 HD015 HDO016 HDO17 HDO018

Bl | Add list E Delete list
Rename Move up

Datavideo Technologies Co., Ltd.
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Move down Add template

Delete template Apply template

Export template

]
Import template
=

Refresh template library Show/Hide template name

TR

50 Replace Selected Template Quick View

Use the Zoom In/QOut bar or “Zoom In/Out” buttons to zoom in/out of the template library.
From the template Menu Bar you can choose different template catalogues, such as Shader
Templates or Image Templates.

Shader Style 30

AV

Changing template name:
Method 1: double click on the template name, enter a new name and then click on “OK”

w Rename

HD002

ut with curren

Explorer
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System Library

Texture

ﬂwwums‘;
N |

System Library options:

N .

-
I

Bal | Add list B=a | Delete list
Rename Move up
Move down Add file
= Delete file m Apply file
Import file Export file
E Refrest System Library

Right click on an empty space:

Add file

Import file
Empty file
Select all
Invert selection
Clear selection
Refresh

Small icon
Middle icon

Large icon

Datavideo Technologies Co., Ltd.
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Right click on a file:

Delete file

Rename

Apply file

Export file

Local file in explorer

Move to previous file position
Move next file position

Move selection to

Copy selection to

To delete a file either:

a. Select a file, then press Delete on the keyboard or right click and choose “Delete”
from the context menu.

b. Select a file and press the Bl button.

To add a file either:
a. Presson , or double click and choose a location to import from.
b. Right click, then choose "Import" from the context menu.

To edit a template name:
1. Choose a catalogue

Texture

2. Pressonthe “Rename” button, then enter a new name

3. Press “OK” to confirm. Press “Cancel” to exit without changing name.
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Create Object

CG-500 provides a large number of default objects, including shapes, Bezier shapes,
horizontal/morph/curve titles, images, animation, clock object, etc.

Operation flow

Most object creation follows the same basic operation flow:

1) Click on the object toolbar and select object type

2) In Still Mode, click on the object and adjust size.

Note: Hold Ctrl when adjusting to keep vertical/horizontal size proportional.
3) Release object.
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Shapes

® Following the basic operation flow, other shapes can be created.

® Shape properties

In the lower half of the Properties
Window you can find the shape's
special properties.
Activate/Deactivate the “Fill” option
to set Line Width.

Choose object shape in the drop-down
list. Changes will also take effect in the
Edit Screen.

Datavideo Technologies Co., Ltd.
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Shapes with Fill mode deactivated.

Changing shapes: rectangle to triangle

1) In the Edit Screen, click on the
rectangle.

2) In the Properties Window 3) Object becomes triangle.
drop-down list, select Triangle

v Fill Line Width

Triangle

Shapes with special properties:
1. Round Rectangle: set Radius parameters

vV Fill LineWidth

Round Rect 3

(= 0.90

2. Parallelogram: set Incline parameters

Vv Fill LineWidth

Parallelogram §

Incline 0.75
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3. Star

Depth: set Depth between points
Face: set number of points
Depth Reset Parameters: resets all parameters

Face

Different Face parameters

Different Depth parameters

4. Polygon: Face parameters set the number of sides

vV Fill LineWidth

Polyaon -

5. Pie Shape

Angle: set Pie angle and angle size

0.00 60.00
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Example

90.00

Change angle

113.00 90.00

Change angle size

6. Line: set Line Width

Bezier Curve

The way to create a Bezier Curve and a shape is not the same as for other objects.
1) Inthe Object Menu Bar click on “Bezier”

File Edit |Object! Option Scroll

Note: The "Bezier Curve" icon is a drop-down button, click and select "PaintStroke" to create
hand-drawn objects. For more complete instructions please see the " PaintStroke " Chapter.
2) In Still Mode, set the Bezier Curve Anchor Points.
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Note:

a. If you release the left mouse button straight away, both the Anchor and Control Points

will be created

b. If you keep the left mouse button pressed, you can first set the Control Points, and then

create the Anchor Point.

3) Join the last Anchor Point to the Start Point to complete the shape, or double click/press

ESC to finish editing.

4) Double click on the Bezier Curve to resume editing.

5) In edit mode, right click to see the following context menu

ext Node

Smooth: smoothen lines between points
Sharp: sharpen lines between points

Delete: delete point

Lock/Unlock: prevents point from being edited
Set Start: set as start point

Enable: you can disable the point

Combine Move: move Control Points together

seperately

Close: close/open curve

or

PaintStroke

® Operation flow

1) Click “PaintStroke” in the Object tab.

Datavideo Technologies Co., Ltd.
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2) Inthe Editor Screen (still), left click, and drag.

3) Release left mouse button, press ESC to exit.
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Example:

Image

The operation flow for images and objects is similar, the only difference is that an image file
needs to be chosen in the Properties Window.
1) Inthe Object Menu Bar choose “Image”

fitor File Edit |Objecti Option Scroll Device Datavidet

2) Set position and size in Still Mode. Release mouse cursor.
3) Inthe Properties Window select an image file (and Mask if needed).
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Hign Cluality
Invert Alpha

Binarization

Invert

Blur

Enable “3D Stereoscopic Image” and
select “Single/Dual”

Browse and select file and show file
name

Show image height and width and
enable/disable “Origin”

Clip image

Set mask parameters and blur
parameters

Whole Transparency Control: Set whole
transparency (disable when enabling “3D
Stereoscopic Image”)

The options are used when image object
have shaderstyle property(Face, Outline,
Shadow)

Datavideo Technologies Co., Ltd.
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4) Example.

5) Double click to Crop

Datavideo Technologies Co., Ltd.
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6) The selected area will expand to the original image size

7) Press ESC to exit

Animation

Create Animation and Create Image operation flows are similar.
1) Inthe Object Menu Bar click “Movie Video”.

File Edit |Object| Option Scroll

SI=IES

2) In Still Mode, adjust size and position.
3) Release mouse cursor
4) In Properties Window select animation file and set parameters.

Present: set start frame

Time In: set start time point
Time Out: set end time point
Repeat: set repetitions

Trim In: i = Origin: go to animated object
original position

Trirm Cut:

5) Create complete
Using animation templates
A large number of preset animated objects are provided. Go to the templates library and

double click on them to use them.
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Uniitied

A

Uniitied
Untitled

Untitied

00:00:00:00
Uniite
Trimin: | 0
Trim Qut: 101
Repeat: | 1.00

Lightearth edeartn Greenearth a asketba Football

Gift Box 1 GiftBox 2

Note: If you double click on an animation in the templates library when an animation has
been selected in the Edit Screen, it will be replaced.

Horizontal/Vertical Text

Normal-frame and Set-frame Text options are possible.
® Create Normal Text
1) In Object Menu Bar choose “Horizontal Text”,

Note: hold cursor to choose “Vertical Text”
2) In Still Mode, adjust text size and position,

3) Enter text,
Method 1: enter text

Enter Text
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Method 2: copy and paste

Right click in text editing state and choose “Character Map” from the context menu.

4) Press ESC or double click to exit
5) Double click on text to continue editing
® (Create Set-Frame Text

1) In Object Menu Bar choose “Horizontal Text”

Fle Edit |Object! Option Scroll

=R

2) In Still Mode drag cursor to desired frame size
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3) Enter text. If text exceeds frame it will automatically move to the next line.

Fnter text...

Ll;lnter text,
utomatically move to
he next...

Text will automatically adjust when frame is shifted.

Enter text, ;
utomatically move to
rhe next...

= = = = — = — = =

Llinter text, a;ltomatically

ove to the next...

4) Press ESC or double click to exit
5) Double click on the text to continue editing.
® Properties

Text Titles have many properties. Simply double click on the desired text to start editing.

3 e .yth’

s'llse) @ettiing ready s

secret: Of f*Jl,JGC@S;.

\
T
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Morph Text

® (Creating Morph Text uses the same operation flow as Normal Text.
1) Inthe Object Menu Bar select “Morph Text”

File Edit |Object| Option

 [O -

2) In Still Mode adjust text position, then enter text

3) Edit Morph Text curves (see also Bezier curve editor)
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5) Press ESC to exit. Example:

6) Double click on text to resume editing.
® Morph Text control curves have three settings:
Separate - control curves independently
Same - control curves together
Inverse - curves do the inverse of each other
Set in two ways
1) Rightclick on the text and then choose from the context menu
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2) Select in the Properties Window

MorphText Template Library:

Inverse

b Diniaiui' an Tt ! P Tt
010N Tes, “Storction T2 ivortion 7 “AbrcfionTes

clien
L T,

Marugar?. esorcionTer Disorton e

W mestorction lrEﬂ.

Distofction vers - -orctionTex| Distorction Text pisters+ion Tuyy

Example:
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Curve Text

® QOperation flow similar to Normal Text

1) In Object Menu Bar select “Curve Text”,

2) In Still mode use the Bezier curve method to create curves.

3) Enter text
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4) You can also choose preset Curve Text styles from the template library.

5) Press ESC to exit. Example:

6) To resume editing, double click on the text.

Clock Object

® To create:
1) Inthe Object menu bar, click on the "Clock" button.

File Edit |Object! Option

=R

Note: The "Clock" button offers various choices, from the drop-down menu you can select
"Number" or "Time Code".
2) In the still editor window click on the starting position, then left click to drag the object
to the appropriate size.
3) Release the mouse button to complete operation.
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4) Setting clock time parameters:

1. Using the system time, the default length can be adjusted freely, with the default set at

4 seconds.

2.

Duration

v Count Down

Duration

+ Count Down

Front Lable

Back Lable

Lan e English

Start time: set the start time. Select system time to
set the current system time as start time.

Default length: Set playback time. After setting the
countdown, the duration will be shown.

Display Type: Select digital clock or dial clock.
Cut-time: switch to cut-time mode

Accumulate-time: switch to accumulate-time mode
Display Format: Select the time display format

Dial clock: use dial clock

Straighten: square shaped dial clock

Label front: enter text before the clock

Label back: enter text after the clock

Language: Select language
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Example:

A 16770.03
Clock .

Beijing ~ New York . Paris

10:03

Number Object

® To create:
1) Inthe Object menu bar, click on the "Number" button.

2) In the still editor window click on the starting position, then left click to drag the object
to the appropriate size.
3) Release the mouse button to complete operation.
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Number object parameters

Minimum Di...

Display For...

v Thot

Front Lable

Back Lable

Lang

Initial value: Set start numerical value

End value: Set end value

Keyframe interpolation: Enable/Close key frame
interpolation functions

Decimal: set decimal number values

Minimun digit: set smallest whole number
Display Format: Select the display format,
including numerical values, spelling, percentage,
etc.

Three units: three separate digital units to be
displayed

Label front: text to the left

Label back: text to the right

Language: Select language

Examples:

Timecode

® To create:

January
| 1 February

™ March

Number Demo

1) Inthe Object menu bar, click on the "TimeCode" button.

Scroll Device Datavidet

2) In the still editor window click on the starting position, then left click to drag the object
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to the appropriate size.

3) Release the mouse button to complete operation.

Time code object parameters

Start Time code and Current Time Code will be

Current Tir discussed later.

Value 00:00:00:00

* Duration Interpolation
_ R View Format: select format.
puraten Ao anaEas Discard Frame: discard format
HMSF(00:00:00:00) Frame Rate: select frame rate.
Front Marker: enter time code left text.

fimecose LI B E Back Marker: enter time code right text.
Front Lable

Back Lable

Set start time code:
1. Current Time Code mode: set Current Time Code mode, modulate deviance, but default
length are unchangeable.

Current Tim ] Start Value

Duration

2. Start Time Value mode:
When selecting Default Length, default length can be changed.

Current Tim

Start Value 00:00:00:00

* Duration Int

Duration 00:00:04:00

3. When selecting Keyframe Interpolation, end time code can change.
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Current TimeCode Start Value

Start Value

Duration * |nterpolation

End Value 00:00:00:00

Examples:

00:00:03:07

‘ January
N February

™ March

Number Demo

Date Object

® To create:

1) Inthe Object menu bar, click on the "Date" button.

I ET———

L AL ——
vVla Logo002

2) In the still editor window click on the starting position, then left click to drag the object
to appropriate size.

3) Release the mouse button to complete operation.
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Date Object Parameters

Select “System Time” to set the
System Time current system time as start time.

* Lser Define ednesday, May - Select “User Define” to set time as

needed.
Neek Select the display format

2012 June 04 Display Format: select date format
Language: Select language

guage English

Set Date
System time code:

Set to system date, and default date is unchangeable.

* System Time

User Define ednesday, May

2012 June 01

Language English

Define date code:

When selecting “User Define”, date can change.

May, 2013

S5un Mon Tue Wed Thu

2% 2 30 1 2 3

5 6 7 8 9 10
PrRmE 12 13 14 16 17

19 20 1 2 3B M

6 27 28 29 30 A
2 3 4 5 ] 7

[ Today: 5/15/2013
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Display Format

Choose a date format from the drop down list.
em Time

* ser Define ednesday,

Display For...

Language

un 01
! Jun 1
Ine 01
' June 1
12 Jun 01
12 Jun 1
June 01
June 1
Jun 01

Examples:

2013-05-15

Wednesday

Flag

® The create flag operation flow is similar to that of objects, and will not be presented here.
® Choose a flag from the Properties Window
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The flag name and abbreviation will be shown
below.

To find a flag, enter the full name or abbreviation
into the "Find Name" field, then press “Search”.

Press “Origin” to place the flag in its default position.

Origin

To find a flag, enter the full name or abbreviation into the "Find Name" field, then press
“Find”.

Find Range Flag 18

Flag AbName

Flag English Name

Find Mame
Find

Origin

Flag AbMame | RUS

lag English Name | Russia

Find Range

Find Name [CHM

Find Fi

Edit flag:
In Flag Library left click, select desired flag, then click “Edit”.
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In the pop-out Edit Frame, enter property parameters, click “OK”.

Object Group

Objects groups can be used to quickly manipulate multiple objects. Use groups to:
1) Rescale, rotate, etc., whole groups simultaneously

2) Use object groups' properties to produce different play effects.
B Make Group:
a. Inthe Edit Screen select multiple objects/text, then use the shortcut Ctrl+G
b. Inthe Edit Menu Bar choose “Make Group”
c. Inthe Edit Screen, right click, then choose “Make Group” from the context menu

Ctrl + G

Locked L
v Visible Shift + ¥V

B Undo Group:

In the Edit Screen select the group, then use the shortcut Ctrl+U

In the Edit Menu Bar choose “Undo Group”
¢. Inthe Edit Screen, right click, then choose “Un Group” from the context menu
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Ctrl + U

Locked L
v Visible Shift + V

Cut Ctrl + X

Path Group

Path Groups use Boolean editing to create new, individualised object types.
B Choose multiple objects, then right click, use shortcut key or Edit Menu Bar to
apply Boolean
)

LI 1

Make Group Ctrl + G

Move Up Ctrl + FPagelp

Move Top Ctrl + Home

Locked L
v V¥isible Shift + ¥

Cut Ctrl + X
Copy Ctrl +C
Paste Ctrl + V¥

Delete Delete

Boolean Union Ctrl + '+

. . Boolean Subtract Ctrl + -
Mix Option 4 % -
Boolean Xor Shift + '+

Align Objects 4 Boolean Intersect Shift + -

Center Object Pivot Ctrl + M

Boolean Union (Ctrl +'+') - merges two objects
Boolean Subtract (Ctrl +'-') - subtracts one object from the other
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Boolean Intersect (Shift +'-') -intersect between objects remains
Boolean Xor (Shift +'+') - intersect between objects is removed

Example:

® To apply artistic effects to normal text, you can turn it into a Path Group.
1) Create normal text

Arts

2) Transform normal text into Path Group by typing Ctrl+P or right click then choose
"Text Block"- "Text Block to Path Group"
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3) Double click on the Path Group to edit
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Example

PathGroup to Object

1. Create objects and save them as PathGroup
Two objects

Adjust the position of objects and save them as Pathgroup with “Boolean” option.
Please check pathgroup section for detailed information.
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2. Right click on the pathgroup and select “PathGroup to Shape” in the right click menu,
or use hotkey “Alt+P”.

3. After the above-mentioned operation, it will become a shape.
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Applying Shader

Shader Properties

Shader properties include: Color, Texture, Linear sheen, Bitmap sheen, Bump bitmap,
Concave, and Bevel. An object's Face, Edge, Shadow and Depth have similar properties,
allowing for different combinations.

Colors

You can set Colors as: Color, Gradient, Quad Gradient, Bmp Gradient.

Color

El Reset
:l Set  single

. color. Click to see
Pipette _
colors library.

RGB format

Preset color HSB format

bar

Color scroll
bar

Alpha scroll bar

The "Color" section has 32 preset colors, and 8 RGB Alpha combinations. To set color:
Choose one of the 32 preset colors

Use the cursor to pick a color from the palette

Set parameters in the RGB Alpha fields

Use the scroll bar

vk W

Use the pipette
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Gradient Color

L——lGradient preview
¥ Color gradiant | Under gradient preview,
e GravOiad,  BamC scroll bar select gradient type,

HJ - TSR count and angle.

Gradiant style Different parameters

EEET = B R s can be set depending on
| G| 240 radient type.
HEN | S Color Marker & P
2 1

First click on Color Marker, then
pick color.

Gradient

Choose color | Use the same method as with

from palette ;
b single color to set any color on

Marker each Marker.

Click under the gradient color bar to add a
Marker, drag to set position. Press Delete to

remove Marker.

Set the central position between colors
using the blur block over the gradient color

bar.

Change Count, Angle, and XY parameters by

Count 2 Angle 40

imputing numbers directly or dragging the

cursor left-right.

Gradient type

Choose gradient type from the drop down
Linear ¥ list: linear, circle, clock, rose line or

rectangle.
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Linear gradient

Colour

Gradient

Angle

In Linear you can only set color, count and
angle. Use angle to set the direction of
colors.

Example

Circle gradient

Gradient | Qua

Gradinet

Datavideo Technologies Co., Ltd.
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In Circle you can only set the X, Y parameters
for effect.

G

r
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Clock gradient

Gradient | QuadGra

ST

Divisions between colors are like clock needles.

All parameters can be changed.

Example:

Rose Line gradient

T .
oselLity

Gradient
“&
- | i
A
HEE *"‘W
||

As with Clock and Rose Line, all parameters
can be changed
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Example:

Quad Gradient

Quad Gradient: four colors are chosen at four
points

Setting Quad Gradient: as with single colors,
choose color for each point.

Example:
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Bump Gradient

Choose a Bitmap Gradient from the System

BmpGrad Templates Library, double-click to apply. Then
set colors.

,f%(ﬁl:l

h—-~
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Texture

¥ Texture

Tile

e Library: choose a template from the
library

El Reset: reset parameters

XY Scale: set block size

XY Offset: set block position

Strength: set texture strength/visibility

Linear Sheen

¥ f LinearSheen

Position

Width

Strength

71 colors: set linear sheen colors

El Reset: reset parameters

Position: set linear sheen position

Angle: set linear sheen angle

Width: set linear sheen width

Strength: set linear sheen strength/visibility

Linearoheen

Bitmap Sheen
AddLight Type

Datavideo Technologies Co., Ltd.
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A1 colors: choose bitmap sheen color
@ Library: choose a style from the
template library

Type = AddLight

Blur
E Reset: reset parameters

Strength

Blur: blur bitmap sheen
Strength: set bitmap sheen strength

You can pick between Add Light Type and Mix Light Type

Bump Bitmap

Set Colors, Angle, Height, Strength and
Type (Tile/Stretch)
You can pick a preset template from the

¥ ' BumpBitmap
Type Tile

Angle

“a- ) library.

. Press Reset to delete set parameters.
Height
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Concave

¥ ' Concave

Mode Raize

Bright

Blur

Set Colors, Style (Raise/Concave/Light
Border), Brightness, Blur, Angle and
Height.

Press Reset to delete set parameters.

..-\‘ » —~ .
'k‘ﬁﬂx-q‘”' =

Bevel

Set Colors, Size, Depth, Angle and Light
Depth.
Press Reset to delete set parameters.
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Face

In Face you can set the following properties: Color, Texture, Linear Sheen, Bitmap Sheen,

Bump Sheen, Concave and Bevel

v Texture
W Line: een
BitmapSheen

v BumpBitmap

HE e

EReset: resets all parameters to their
original values.

ﬁDelete: deletes Face
EFoId/Expand: Folds/Expands all
Face properties

FoId/Expand: Folds/Expands Face,

Edge, Shadow, Depth properties

Edge

In Edge you can set the following properties: Color, Texture, Linear Sheen, Bitmap Sheen,

Bump Sheen, Convave, Bevel

Nidth | 2 Blur, O

v Texture

LinearSheen

¥ / Qutline Normal
Width
b Col

Color

Datavideo Technologies Co., Ltd.

¥ + Outline Morrmal
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=

HE =

=

As with Face you have Reset, Delete and
Fold/Expand properties.
Unique to Edge: Width and Blur
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Nermal Ouil ine

I

Shadow

In Shadow you can set the following properties: Color, Texture, Linear Sheen and Bitmap
Sheen

¥  Shadow As with Face you have Reset, Delete and
wion [BE ] Fold/Expand properties.

Unique to Shadow: Width, Angle and Blur

properties.

Image

LinearSheen

Bitm

Depth

In Depth you can set the following properties: Color, Texture, Linear Sheen and Bitmap
Sheen.
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As with Face you have Reset, Delete and
Fold/Expand properties.

As with Shadow you have Width and
Angle properties.

You can set Shadow type by clicking on
the drop down list.

¥ +/ Depth Normal & | @R &
Mormal
Inne

v

Color

Example

Frame

In Frame you can set the following properties: Color, Texture, Linear Sheen and Bitmap

Sheen, Bump Sheen, Concave, Bevel.
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¥ /' Frame Square

Nidth 20 ai | 100

Colour

v Texture

Linearsheen
BitmapSheen

v BumpBitmap

As with Face you have Reset, Delete
and Fold/Expand properties.

As with Shadow you have Width
and Angle properties.

Unique to Shadow: Height, Offset
and Space properties.

You can set Frame type by clicking
on the drop down list.

v Frame

Vidth | =V
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Advanced properties

Outline
Depth

Invert Blur

You can apply Mask effects by going to the bottom of
the Shader Tab. Here you can apply a Mask from the
template library, set the blur level and
activate/deactivate the Inverse option.

Setting Mask

1) Enter atextin the Edit Screen, then choose

from the Shader Tab.

2) Click on the “ button to choose a template. Double-click or press ﬂ to

apply.

Datavideo Technologies Co., Ltd.
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&#Dumcumu
R e
WS=ES s

E:.,i[ JOE;!

e

Set Mask Blur parameters
Example
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Editing properties

Combinations

Enter text/object on the Edit Screen, open Shader, and then pick Face, Edge and Shadow.
You can also pick Shader properties first and then input text/object.
By default, when you first enter text only Face is opened. Add other properties.

Click the “Insert” button to add Outline over Face.

Note: you can click the “Insert” button to insert a shader property over the selected
property.
The text add a Outline property:
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A60

BumpBitma

To delete a property, choose the unwanted property and then click on either of the “Delete”
buttons shown in the screen below.

Example

Step 1

S60

Mormal

Blur| O

Step 2

420 440 bl

Move between properties by using the mouse cursor or the / buttons,
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420 440 Sa0 il L] o

Marmal

Blur| 0

Example

ngle| 45

Harmal

=TI

Using different properties combinations you can produce all sorts of Title effects. Example:

Preset Styles

You can choose a Preset Style by clicking on the drop-down list shown below.
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4490 560 B30 L] i

Solid Style

Outline Style
v Pure Color

Custom Style

480 bl B 7on o

»  Outline Marmal

Width| 2 Blur| O

Angle

Shader Template Library

At the bottom of the Shader tab you can open the Templates Library by clicking the -

button.

Use the “Add/Delete” buttons to
add/delete templates to/from the library.
Hide the library by clicking on the “Hide
Library” button.

Right-click on a template to see the context menu:
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Apply All{Ctrl

Apply All: applies shader and format properties to
current text

Apply Shader: applies shader properties to current
text

Delete

Apply all except font height

Export template

Locate file in explorer

Move previous

Move next

Right-click on an empty space in the library to see the context menu:

Add

Import

Empty

Choose all
Invert selection
Clear selection
Refresh

To add a template you can:

1. Pressthe button in the library

2. Choose Add from the options context menu.
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Invert Select

Refresh
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To delete a template either:

1. Pressthe = button in the library
2. Choose Delete from the context menu
After creating text in the Edit Screen, the easiest way to apply template properties is to

double-click on the desired template.

Depth

Apply ALl (Ctrl+DbCLick)
A 5! i £LHDBCLick)

Delete

Apply A1l Except Font Height
Export

Mowe Prev

Mawe Hext
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B
Depth

[00:07:00  00: 0 00:00:04:00  00:00:05:00  OC

Apply AL (Ctrl+DbClick)
Apply Shader Style (Shift+DbClick]

Delete

Apply All Except Fomt Height
Export

Wove Frew

Move Hext

Render Text

As part of the shader properties, you can choose to render the text as a whole or letter by
letter.

Render All: applies Shading effects to the text as a whole.

Individual Render: applies Shading effects letter by letter.

Set the Render format by clicking on the button in the Text Editing Bar
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Render Image

Specific properties of render image are shown below.

Threshold

Note: the options are used when image object has shader style property (Face, Outline,
Shadow).
Example:

adjust shading
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Graphics (Still) Editing Mode

Position, Scale, Rotate

To move an object:

1. Inthe Edit Screen drag the object to the desired position.
2. Click on an object and use the arrow keys on the keyboard. Press Ctrl to increase

speed.

3. Enter co-ordinates in the properties tab.

Step 1:Click on the object in the Edit
Screen

HEADING
Subheading
Subheading

Step 2:Enter XY coordinates

40463
0.0
10000 | =1 100.00

Zoom Object:
Method 1:

Drag the markers surrounding the
object. Hold Shift to keep XY scale

constant.

HEADING

Subheading
Subheading
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Method 2:

Enter XY scale in the Properties tab.

Press on the lock to keep XY scale | [

constant. Destribe
Pasition 404 63
Ratation 0.00
scale 100.00 | = v 100.00
Shear 0.00 i n.oo
Pivvat 0.00 i 0.00

Rotate object:

Method 1: On the keyboard, hold Shift, then use the Up/Down arrow keys to rotate 45
degrees. Use Right/Left arrow keys to rotate 1 degree.
Method 2:

Enter numbers in the Properties tab

Rotation field.

Marne

Describe

Pasition

Ratation

Scale

Mix Marmal

12569

100.00 | o ¥ 100.00

Shear e 0.00 i 0.00

Method 3:

Move the cursor to the marker in the
centre of the object

A circle will appear

Drag the marker around the circle to

perform rotation
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Make Group, Ungroup

Make Group will turn many objects into one. To make a group:

1. Hold Ctrl and choose objects, or press Ctrl+A to choose all objects in Edit Screen.

2. Press Ctrl+G or right-click and choose “Make Group” from the context menu. You

can also press on “Make Group” in the Edit Menu Bar.

Example

To Ungroup press Ctrl+U, right-click and choose “Ungroup”, or press “Ungroup” in the Edit
Menu Bar.
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Example

Boolean

Boolean is a special form of grouping and includes: Union, Subtract, Intersect and Xor.
To perform Boolean grouping, choose objects then:

1. Use the keyboard shortcuts (Shift+'+', Shift+'-', Ctrl+'+' or Ctrl+'-")
2. Right-click and choose from the context menu.
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Make Group Cirl +

Locked L
v Yizible Shift + v

Cut Ctrl + X
Copy Cirl + C
Paste Cirl + ¥

Delete Delate

Boolean Union Cirl + '+
Boolean Subtract Ctrl + '~
Eoolean Xor Shift + '+
Shift + -

Mix Option

Mign Objects 3
Center Object Fiwvot Ctrl + M

EBoolean Intersect

3. Press “Boolean” in the Edit Menu Bar

File | Edit

Example:
Boolean Union

Boolean Subtract

Boolean Intersect
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Boolean Xor

Object level

When you have several objects in the Edit Screen, you can set level by:
1. Using the keyboard shortcuts: Ctrl + PageUp, Ctrl + PageDown, Ctrl + Home, Ctrl +
End,
2. Right-click and choose from the context menu.

Ctrl + End
shift + v

Alt + E

3. Press “Level” button in the Edit Menu Bar

File Edit Ohject Qption Scrall

[

=140 =i
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Mix Option

There are two Mix options: Mix Normal and Mix Penetrate. Two ways to apply:
1. Use keyboard shortcuts Ctrl + T, Shift + T,

2. Right-click then choose from the context menu

<alCllow

Example

Mix Normal

Mix Penetrate applied to text

Mix Penetrate applied to
object

3. Choose from the Properties Tab
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Mame Rectangle

Rectangle

Mix Mormal

10000 | =

Align

To align objects you can:
Press “Align Objects” in the Edit Menu Bar,

Right-click and choose “Align Objects” from the context menu
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Example
Choose Objects:

Datavideo Technologies Co., Ltd.
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When you have more than three objects, you can align range using the “Align Space” button in
the Edit Menu Bar or right-clicking and choosing from the context menu.
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Vertically centre multiple objects
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Horizontally centre multiple objects

Centre multiple objects

Multiple objects full-screen

Smart Borders

Smart Borders help you align objects. The border lines will illuminate whenever an object

touches them.
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1. Create an object
2. Dragthe object to one of the Smart Borders
3. Border line is activated

440 560
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Smart Borders along the edges will turn red, whilst the center lines will turn yellow.
In Roll/Crawl settings lines will appear red.

Applying effects

Object effects have two sources: those preset in 3D Transform, and those that have been added
from effect files.

3D Transform

1) The effect's play time and Timeline track duration are always equal.

2) An object's 3D Transform effects include Displacement, Scale, Rotate, Pivot and
Transparency.

3) Timeline display

Transopare...

= » &% 3D Transform
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In the picture above we can see Displacement Keyframes
4) Parameters in the Effects Tab:

1
rm O REA = E

Translate

Displacement

Displacement refers to the position of an object at a specific time in space. Where the object
moves depends on the set route and starting position. Example:

Translate

Object starting point and trajectory

Scale

Scale refers to the size of the object at a specific time in space.
Example:
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Rotate

Rotate refers to an object's rotation movements at a specific time in space. The object center is

the center of rotation. Example:

Pivot

Pivot refers to the size of the object pivot at a specific time in space.

Transparency

Transparency refers to how transparent or opaque and object is at a certain point in time.
Example:

:'“Fransp:arencyz

Transparency at 100% and 47%
Applying 3D Transform

To apply 3D Transform:
1. Press F10 to open Effect Edit Mode
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00:00:00:00

ry
2D Pan
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4. If Keyframe animation is needed:
a. Activate Keyframe animation parameters as shown below

T 1
O qMEER= E

B
[
[
B
B
(5

» Fx 2D Pan

b. Move the Timeline Marker to the desired location
c. Click on Keyframe Marker to add keyframe (see below)
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d. Use the Effect Tab or the Edit Screen to adjust parameters

Creating Keyframes

Add keyframe: after moving the timeline click on the add keyframe button,

G
E
B
5
e
@
B
5

Delete keyframe: move the timeline onto the keyframe, click on the delete keyframe button.
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Copy keyframe: right-click and choose "Copy" on selected
shortcut Ctrl+C to copy.

Right-click context menu

Datavideo Technologies Co., Ltd.
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Cut

Copy

Paste Value
Delete
Reset
Constant
Linear
Speed Up
Speed Down
Ease in out
Custom

Copying keframes to other clips: right-click on the 3D Transform track of another clip to see the
context menu

When clicking on a single track all keyframes on that track will be selected, as shown

below:
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000117

1410 0e:00:02:0

Right-clicking on the rectangle shown above gives the following context menu: (This
operation only affects the current track)

Copy keyframe linked list
Paste keyframe linked list
Reset keyframe lined list

Invert keyframe linked list

Keyframe interval list

Create Freehand Path

Use freehand path create a Bezier motion path for object to move on. Adjusting the parameters
of the Bezier curve any time to change motion track of the object.

1) Create object in the editing area, press shortcut key F10 to switch to effect editing mode.
Click to select the object in editing area, and then click Create Freehand Path button under
effect menu.

Press and hold the left mouse button to draw a path in the editing area. After drawing a path,
release the mouse button and click right mouse button to escape.
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As shown in the following picture, the motion path can be adjusted just the same way as
Bezier curve. For detailed instruction, please refer to relevant sections.

Create Bezier Path

Create motion path for object with fast Bezier tool. After it’s done, object will move following the

path. Bezier path can be adjusted freely, thereby changing the motion path quickly.

1) Create object in the editing area, press shortcut key F10 to switch to effect editing mode.
Click to select the object in editing area, and then click on Create Bezier Path button under
effect menu.
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2) Click left mouse key in the editing area, create a Bezier curve node, then move the cursor and
click a few more times to create a Bezier curve. Drag your mouse horizontally and vertically
allows creating Bezier curve with different radian and angels.

3) Drag the nodes to change the position of the curve. And adjust curve radian with the handle
at the nodes. For detailed information about Bezier curve, please refer to relevant chapters.
Move the timeline to preview the animation.
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Create Ellipse Path

Create oval motion path for object with Ellipse tool. After it’s done, object will move following
the ellipse path. Ellipse Bezier path can be adjusted freely, thereby changing the motion path
quickly.

1) Create object in editing area, press shortcut key F10 to switch to effect editing mode. Click to

select the object in editing area, and then click on Ellipse button under effect menu.

2) Press left mouse button in the editing area and drag. Release the mouse, and the point will
appear as shown below when you move the mouse. Move the cursor to right position, and
then right click to create an oval path. The movement starting point is shown in the following

picture.

3) Drag the nodes to change the position of the curve. And adjust curve radian with the handle
at the nodes. For detailed information about Bezier curve, please refer to relevant chapters.
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Move the timeline to preview the animation.

Effect composition

There are many template effects that can be added to an object preset effects, including: 2D Pan,
2D Stretch, Linear Dither, Region Dither, Shine, Star Glow, Lens Flare, Stripe, Sparkle, Linear Light,
Radical Light, Image Light, Lens, Wormhole, Swirl, Ripple, Circle Lens, Page Curl, Page Turn, Gauss
Blur, Radical Blur, Motion Blur, Box Blur, Spin Blur, Wipe, Mosaic, Flick.

1) The duration of added effects can be freely modified

2)  All keyframe effect parameters can be edited

Track example

Effect Tab example
; 511
v  Shine ERe®E|

At Channel yhten Chant 5
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Effect Templates Library

The software supplies many preset templates for every effect. Double-click on a template to

apply it to the object. Example:

Duration € 00:00:01:00 %

“In” Button - set when an effect should appear

“Stay” Button - set how long an effect should appear

“Out” Button - set when an effect should disappear

Effect Template Library operation buttons: Add Effect, Delete all effects, Refresh library, Show
Text List

Click on a category to see the full list of effects
ion Dithe [i*

Shine
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Text effect

Text is the most commonly seen title format on television. CG-500 adds a new scope to how text
can be played, including Whole Text, Line by Line, Letter by Letter, enter progressively exit
instantly, and much more. The user can add play areas and styles according to need.

Setting play area

Right-click on the text bar in the Timeline (shown before) to see the context menu:

Text

@ 30 Transform

v Enable Area Enable/Disable

Add area in Timeline
Delete area in Timeline
Text enters letter by letter
Text exits letter by letter
Text enters line by line
Text exits line by line
Whole text instantly visible
Sets play frequency

Sets uniform play areas

Resets play area

Text will be play according to set style and effects.

00:00:00:00 -8 B 3
00:00:00.00

In the picture above you can see three play areas, each with its own style:
TT 02000 (&

The first play area is set to play by letter, 0.2 frequency, with effects shown in the red field.
The second play area is set to play whole text, with effects in the red field.
TT 0.2000 (B
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The third play area is set to play by letter, 0.2 frequency, with effects in the red field.
Example
Curl in by letter

Setting te;

Flash whole text

Setting text play area

Fade out by letter

t play area

Play Frequency and Duration

Frequency (q) must be between -1.0 and 1.0, used to determine letter/line in time, play time etc.
1) Frequency only has effect when play by letter/line is set
2) Frequency can be set in three ways:
i) Right-click, set frequency from context menu

Enable/disable area
Add area in current timeline
Delete selected area
Play by char (in)
Play by char(out)
Play by line(in)

Play by line (out)
Play by text
Frequency value
Uniform area

Reset area

ii) Click on the button shown below, choose frequency from drop-down list
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Custom...

iii) Double-click on frequency field, enter number.

After setting frequency, In/Out points and time will be set automatically using this method:
Play time =T, N. of Items = n, other effect time = t, item =i, then:

Play item In/Out intervals = t*q

Play item In/Out = i*t*q

Play item effect = T/((n-1)*q+1)

Example: five items in 100 frames
a. At frequency 1.0 every effect execution time will be 100/((5-1)*1.0+1)=20 frames,

intervals at 20*1.0=20 frames, as in the example to the right.

At frequency 0.2, every effect execution time will be 100/((5-1)*0.2+1=55 frames, intervals at
55*%0.2=11 frames, as in the example to the right.

Frequency +/- determines play order. Example:
Timeline of every item at frequency 0.2

\0:00:01:00 30 oo 0 00000400

Timeline of every item at frequency -0.2
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Play Whole Text
If set to play as whole text, the entire object will appear instantly.
Play In/Out by Letter
In play in/out by letter, every letter will appear according to frequency and effect settings

alLlze I Intast
TT 01000 TT 1.0000 (B TT 0.2000

Scale In By Letter, frequency 0.1

Professiona!

Fade Out By Letter, frequency 0.2

nal User [Interface

Play In/Out by Line

In play in/out by line, every line will appear according to frequency and effect settings

1.0000 ( T=, 0.2000 (v

Scale In By Line, frequency 0.1
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Professional User [Interface

Professional User [nterface

Professional User [nterface

Fade Out By Line, frequency 0.2

Random In/Out Text

Random Text is a subtitle with special effects, with text entering/exiting the screen randomly line
by line or word by word. Select as shown below:

GO0 ()

00 ()

The same method broadcasts different texts randomly into the region.
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P A300:00:00 00:00:07:25
2010 BIAR SHOW
ITT G960 (B T BO0 ()

Set A to play randomly line by line and set B to play randomly word by word, as shown below:
Play to 1.5 seconds:

Play to 5.0 seconds:

» &1:00:00:00 00:00:02:25 00:00:05:00

2010 NAB SHOW
Welcome to Beijing Pavilion

Beijing Videostar Co., Ltd.
Random text

Play to 7.0 seconds:

Datavideo Technologies Co., Ltd. 129



» 000000 00:00:02:25 00:00:05:00 00:00:07:25

)

Object Group Effect

Object Groups are special types of objects which can be used to edit multiple shapes (movement,
scale, rotation, etc.), and can be played independently with many effects.

Setting Play Area

Object Group play areas are similar to Text play areas. The Object Group will play set effects
within the allotted time in the Timeline. These setting can be changed by right-clicking and using

the context menu.

Subheading

In the picture above you can see an example of an Object Group, composed of four objects and

two texts.
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00:00:04,05

Right-click on the play area to choose play options

Enables play area

Add area to the current timeline position
Delete area

Play as child (individually)

Play as group

Make spaces uniform

Resets play area

Object Group will be played according to set style and effects.
In the example above the Object Group is split in two
Part 1. -EEII Set to play as child, each object will use its own effects.
Part 2. N set to play as group, all objects will be played using group effects (in this
case Curl effects)
Example: Text moving in from the left, object moving in from the right (play as child)
Frame 10

Subheading

Frame 14
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SING.
Subheading

Play as child finish

" MEADING 4
Subheading

Example: both text and object play out using Curl effect (play as group)
Frame 30

Subheading

Frame 40

Play as Group

If set to Play as Group, effects will be played equally to all objects.
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Play as Child

If set to Play as Child, objects will play their own effects and group effects will be ignored.

Setting Stay Area

Setting Stay Area for Title

If you want to change duration of dynamic title, when setting stay areas, animation effect will not
be changed.

Add/Delete Stay Area

Right click on the space above timeline, and choose “Set Stay Area In” to add a stay area in. You
can add a stay area out using the same way.

00:00:01:13

Note: choose options from the context menu to clear stay area, scale stay area and so on.
Drag in point and out point to change the stay area duration.

00:00:00:00 » A —

Scale Stay Area

Method 1: right click the stay area and select “Scale Stay Area” from the context menu.
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| 3 .'_‘j -00:00Q:00

Ll |

Type in desired timecodes in the popup Scale Stay Area window and then press Enter.

Method 2: hold Ctrl and drag out point to scale.

| ﬂj 000000 00-00:05.

i

Example:

|2 ﬂj -00:00:00 00:00:

0

Object duration changes, when scaling the stay area, but animation effect does not change.
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Create Subtitle

1) Open CG-500.
In Text properties tab, enter text or click on “Open” button and choose existing text file. Then

and choose “Create Subtitle”.

riiDance, bk

2) Set the text object bold, font size and set text color.

- & P P aTa s ’ ~4 A
SubTitle- 014)

° el @ ®
Got me en'feet. off the ground ¢

3) Add effect
In Effect tab, add keyframe and adjust parameters.
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¥ +/ 3D Transform

> [
> [
* [
> [
> [
> [
> [
* [
> [
* [

# [>  Transpare..

You can also double click effect template to apply.

SubTitle

= SubTitle
= With Pause Point

4) Preset subtitle properties
In Property tab set Effect Mode (Cut, Fade and FX), Align Mode, Play Mode (Interlace and
Sequence) and so on.
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Mame

Describe

Position X 2076 Y| BE4.12
Rotation
100.00
0.00 0.00

Effect Mode
Align Left

Align Top

Flay Mode

If you set play properties in Property tab, subtitle will show the properties in CG-500 Player.
5) Save the subtitle to Template Library when done.
6) Drag subtitle template to Subtitle List in CG-500 Player.
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Create Roll/Crawl

The roll screen is often seen at the end of a movie (in the form of credits). In CG-500 you will find
many powerful roll functions, including 3D roll and Mask roll screens.

Operation flow

Most rolls are aligned, and with CG-500 this can be done quickly and conveniently.
1) In CG-500 choose roll, set roll type (up, right, left), and the software will automatically
change the current layout into a roll screen.

00:00:00:00

2) Import preset roll screen text onto the Edit Screen.
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Set Headings: to set multiple headings, hold Ctrl,

choose headings then press on. NS
C:\Documents and Se

Heading will turn red. All text under a heading

will automatically become its content.

(il

Cont.-Title

3) Press Ctrl+A to select all text, then press button. The text will appear in the Edit

Screen. Press H to center. Example:

Director

Jian Wang Jian Wang
Producer Producer
Yaojun Zeng Yaojun Zeng
Light

Bo Yang

Music

Lei | Zhang

Player

Wen Chen Xiao Li Wen Chen Xiao Li

Miss Li Mr.Green Miss Li Mr.G
Beiling Videostar Co., Ltd Beiling Ltd

Example:
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Director
Jian Wang

Producer
Yaojun Zeng

Light
Bo Yang

Music
Lei Zhang

Player

5) Press to choose all headings, then apply Shader using the Shader Tab. Example:

TfDirectoT

Jian Wan

Produce
Yiiojun Zeng Content

T Lighte ¢

iBo Yang

Music
ei Zhan

The same method can be applied to Contents.
6) Open the Roll/Crawl Tab to set roll parameters.
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StartrRoll In

Liner

Here you can set In/Out format, roll area, Liner, Mask and play area.
7) Save to Template Library when done, and use in CG-500 Player.

Create 3D roll\crawl

1) Use the operation flow above to create a roll/crawl screen.
2) Press F10 to activate Effect Edit Mode, and activate 3D Transform in the Effect Tab.
3) Click on the Timeline 3D Transform track, and use 3D rotate modulator tools to set roll

screen rotation angle.
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00:00:00:00

Page Curl

Other parameters

Fade In/Out

Invert Blur

Invert Blur
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Slow-Motion

Total Time 00:00:04:00

Liner
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Dynamic Texture

When using Shader, other than normal Face, Edge and Shadow bitmap you can also use Dynamic
Texture properties. When played, the object will display dynamic change effects. More than 100
preset templates are available.

Examples:

Applying Dynamic Texture

1) Create an object or text
2) In the Shader Tab area, activate Dynamic Texture and set Strength level (0-100). At O
Dynamic Texture is not applied, at 100 it completely replaces the current object Shader.
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3)

Group
> &% 3D Transf
> 5
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Modify... Modify file

Fill Fit Adjust duration automatically
Add a dynamic texture file
Insert file in current position
Cut

Copy

Paste

Mask

Delete file

Set file play speed

Delete all files

Select all files

4) Choose “Add”, then select from the Dynamic Texture Library. You can make further
modifications in this screen, including color and play speed. To apply, double-click on the
template or select first and then click on OK.

5) Abar will appear on the track,

6) Set the file In/Out points to mirror object In/Out points,

7) Example:
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FB[u 4 @0 ¥ 2 & 4@

0001

CTT— HEARING News

00:00:03:03

Rendering

1) At any point in time, an object's dynamic texture is unique and can't have more than one.
The dynamic texture will automatically choose the first Shader property (be it Face, Edge or
Shadow)

2) For each layout there can only be one Dynamic Texture track, so all objects will make use of
this file.

3) When rendering in real time, if the Dynamic Texture effects cannot be found, the object will
apply the first Shader property (for example Face or Edge)

Examples

Dynamic Texture background 1

Heading News

Dynamic Texture background 2

Heading News

Text Face using Dynamic Texture
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—

Text and Rectangle Face jointly using Dynamic Texture effects

J///

All Reallime
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Applying Settings

Activate system settings
1) Press shortcut key Ctrl+Shift+O.
2) Click on “System Option” button at bottom right-hand corner.

Grid Color

Template

» |mageBk |C:\Program Files\Canc

Template

[V

You can set Edit Screen's background as Solid, Grid, Image and save as a background template
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HEADING HEADING

Subheading

Subheading Subheading

HEADING

Subheading
Subheading

Solid Color

Sets one color as Edit Screen background

Grid Color

Sets two colors as Edit Screen background

* Grid Color

Image Background

Sets a picture file as Edit Screen background

* |mageBk |C:\Program FileshCanc

Background Template

To save as Background Template
1) Choose a background style
2) Choose color or picture file
3) Click on the “Options” button, from drop-down list choose:
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Template

: -

Add: adds background as template
Import: import a background
Delete: deletes background template
Delete All: deletes all templates

Keyboard Shortcut

File Command

There are four major keyboard shortcut groups that apply to different areas:
1) Global

2) Layout

3) Timeline

4) Edit Screen

Note: keyboard shortcuts may be edited in future editions of this software
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User Interface

User Interface

v Enable May

v Timeline View Dynamic

Auto Load Recent Text File nbo

Recent Text File Count:

unt:

Inner

Edit View Dynamic Zooming - double-click to adjust screen zoom

Edit View Prompt Message - prompt messages such as "Save File" or "Apply Effect"

HEADING

Subheading
Subh Graphics

by

Timeline View Dynamic Zooming - double-click on the timeline to adjust window zoom
Auto Load Recent Text File - automatically load last used file at start up
Font Combo Box Standard Style - set font Standard list or Use Current Font list
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Default Input String - press F2 and preset text will appear in Edit Screen
Default Setting

Default £

Default Fade InfO

Frame

t Ration From 4:3 To 16:9: Letter

¢t Data when video Ltion is changed

Default Fade In/Out Percent - applies default Fade In/Out settings for effects in the 3D Transform
timeline track

00:00:00:00 00:00:01:00
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00:00:00;00 00:00:00;25 00:00:01;

Default Object Length - set default object play duration in the timeline

Text Setting

Setting

< [TY) @ [E (=

ont sett. .. T. (T,

Small tex

Small tex

Set default input string.
Special Language Hotkey Process: switch font setting with current font setting
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File Path Settings

Froject Path [Wipplication Data) GiDocument st Projeck),

Text Path 12!\Documents and Sektingsiall User s Application Daks
Image Path [Z:Documents and Settingstal LsersiApplication Data
AukoSave Path 12 \Documents and Settingsiall UsersiApplication Data

SUbTite Path 12 \Decuments and Settings)all Userstapplication Cats

Project Path: sets project path
Text Path: sets text path

Image Path: sets image path
AutoSave Path: sets auto save path
Subtitle Path: sets subtitle path

Auto Save

v Automatically Save Project

Save every step operation

Automatically save every: minutes

Max Directory Capacity: 150 MB

Automatically Save Project: whether save project automatically

Save every step operation: save every step operation in project

Automatically save every *** minutes: automatically save project every the specified time
Max Directory Capacity: set max capacity of auto save path
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3D View Edit Settings

¥ Grid Interyval:

Z Grid Interval:

Axis Line Thickness:
s Line Color;

5 Line Calar:

Grid Line Color:

X Grid Interval: set parameter of X grid interval

Z Grid Interval: set parameter of Z grid interval

Axis Line Thickness: set parameter of axis line thickness

X Axis Line Color: set color of X axis line

Z Axis Line Color: set color of Z axis line

Grid Color: set color of grid

Whether real-time updates Settings: enable/disable real-time update settings
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Export

Click the marked button to select options.
i O - Eh

[E—— —

01

b E

xport all Lay as Pictures...

xport Project include reference files .

Movie—Lightearth

Export Current Layout as Picture

Method 1: press Ctrl+l or click on “File” in menu bar and “Export Layout” in tool bar, then select
“Export Current Layout as Picture” from the drop-down list.

Method 2: right click in Edit Screen and then select “Save Layout as Picture” from the context
menu.

Then the Save as window will appear.
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Savein: -, yuanEpan (H) - @ F o

iz Marne Date modified Type il
":‘“.-i} . 00000 2012/2/28 15:32 File folder
RecentPlaces o 537acf2cal170d4ef120daTe 2012/3/3012:55 File folder

! , DMDownLoad 2012/7/2611:16 File folder |
ducmi 2012/7/2611:16 File folder
Desktop 4. e22bfbbo8b08eal60fIeds 2012/4/1111:16 File folder
—_  EDIUS 6 2012/5/11 18:48 File folder
_J:TJ J Edius new 5 2011/8/2311:38 File folder
Libraries , EDIUS project 20012/7/3010:11 File folder
, EdiusLM 2011/8/1212:10 File folder
::.k Image 201277251556 File folder
Computer InfoTV Projaem 3 2012/2/2017:51 File folder
.:r ) InfeTV Bacfp I I e n a m e2012_a’5.f‘1? 16:48 File folder

A . Lavout 2012/5/22 14:26 Filefolder 7

Metwork L - r

File name: | - Save
Save as type: [Targa ("tga;” wda;"ich;” vst) { Cancel

[ Pixel Ratio Output

In the Save as window set path, enter file name and select file save type then click the “Save”
button.

Export Current Frame as Picture

Click on “File” in menu bar and “Export Layout” in tool bar, then select “Export Current Frame as
Picture” from the drop-down list. The Save as window will appear.
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Savein: = yuanEpan (H:} - f} ? o mv

iz Mame Date modified Type it
..;’D, . 00000 2012/2/28 15:32 File folder
RecentPlaces 3| 537,cf2cal179d4ef120daTe 2012/3/30 12:55 File folder

! , DMDownLoad 2012/7/2611:16 File folder |
duomi 2012/7/2611:16 File folder
Desktop . e22bfbb98b08ealf0fdeds 2012/4/1111:16 File folder
—_  EDIUS 6 2012/5/11 18:48 File folder
_J:TJ J Edius new 5 2011/8/2311:38 File folder
Libraries , EDIUS project 20012/7/3010:11 File folder
, EdiusLM 2011/8/1212:10 File folder
::.k Image 201277251556 File folder
Computer InfoTV Projaem 3 2012/2/2017:51 File folder
.:r ) InfeTV Bacfp I I e n a m e2012_a’5.f‘1? 16:48 File folder

A . Lavout 2012/5/22 14:26 Filefolder 7

Metwork L - r

File name: | - Save
Save as type: [Targa ("tga;” wda;"ich;” vst) { Cancel

[ Pixel Ratio Output

In the Save as window set path, enter file name and select file save type then click the “Save”
button.

Export Current Layout as Movie

Press Ctrl+E or click on “File” in menu bar and “Export Layout” in tool bar, then select “Export
Current Layout as Movie” from the drop-down list. The Export Movie window will appear.
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-_ Height
Subheading News

( — ( Z CG-500 Movie File

Setting properties:
Field Order: select option from the drop-down list.

Original (1920 * 108

Upper Field First
Upper Field Fir |-
Lower Field Fi
Pro i

Set parameters by:

1. Clicking on the field and typing in the numbers
2. Dragging the cursor over the field

3. Moving cursor over the field then clicking on “<, >
Resolution: set parameters of Width and Height.
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File Path: click the “Browse” button, the Save as window will appear.

Select path, enter file name then click on the “Save” button in the Save as window.

—
@uv| .« yuanEpan (H:) » Layout » - | 4¢| | Search Layout )
Organize * Mew folder 4= = (7]
g2 e22bfbbIobl8e *  Name Date modified Type *
, EDIUS B i 3
. , 00000000 2012/4/28 11:57 File fol| =
, Edius new 5 ) —
. , 0000 201272720 10:02 File fol
, EDIUS project )
, 0001 201272720 10:04 File fol
 EdiusLM i )
L , 2011-03-18-01 2011/7/8 14:45 File fol
J Image 5| )
4 , 2011-03-18-02 2011/7/8 14:45 File fol
J InfoTV BackUp )
) , 2011-03-18-03 2011/7/8 14:45 File fol
J InfoTV Project .
, 2011-03-18-04 2011/7/8 14:45 File fol
| Layout .
_ J 2011-03-18-05 2011/7/8 14:45 File fol _
, media

* 4| 1
KAND2

3

File name: Namé|

Save as type: [CG-SD{I Movie Files (*vxmovie)

= Hide Folders

save |||

Cancel ]

Render and Preview: click the “Render” button to render. After rendering, click on the “Preview”
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button to preview the movie file.

The left button is “Render” and the right is “Preview”.
Preview:

Subheading

Export Current Layout as Image Sequence

Click on “File” in menu bar and “Export Layout” in tool bar, then select “Export Current Layout as
Image Sequence” from the drop-down list. The Export Movie window will appear.
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Click on the marked dropdown button shown above and then select option from the drop-down
list.

Codec:

LS.

Please refer to EXport Current Layout as Movie about operation.

Export Current Layout as QuickTime Movie

Click on “File” in menu bar and “Export Layout” in tool bar, then select “Export Current Layout as
QuickTime Movie” from the drop-down list. The Export Movie window will appear.
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list.

Please refer to EXpOI't Current Layout as Movie about operation.

Export all Layouts as Pictures

Click on “File” in menu bar and “Export Layout” in tool bar, then select “Export All Layouts as
Pictures” from the drop-down list. The Save as window will appear.
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mvh_._, v Computer » yuanEpan (H:) » - | \i'vf| | Search yvanEpan (H:) pe |
Organize * Mew folder 4= = I@
B Videos o Mame . Date modified Type il
HET
sl un 1 00000 2012727281532 File folder 3
= B 237acf2call79ddefl20dale 2012/3/30 12:55 File folder
L Computer
| DMDownlLoad 2012/7/2611:16 File folder
&L, Local Disk (C3) , _
] ducmi 2012/7/2611:16 File folder
—a Local Disk (D) )
i 8 e22bfbbo6b08eal 60f9eds 2012/4/1111:16 File folder
—a window 7 new (E )
.. EDIUSE 2012/5/11 18:48 File folder
ca Local Disk (F) _ )
. Edius new 5 2011/8/2311:38 File folder
a yuanEpan (H:) . .
. EDIUS project 2012/7/3010:11 File folder
| 00000 . T
Al 9Tt T |—‘J I | C
File name: m -
Save as type: [Talg.a. {*.tg.a;*.\rd.a;*.i.cb;*.vst}\ vl
“ Hide Folders I Save | [ Cancel ]

In the Save as window set path, enter file name and select file save type then click the “Save”
button.

Export Project include reference files

Export project include reference files to specified directory.
Click on “File” in menu bar and “Export Layout” in tool bar, then select “Export Project include
reference files” from the drop-down list. The Save as window will appear.

’ . - E] » Libraries » Documents » v Search Documents pol

Organize ¥ New folder = v 7}
¢ Favorites — Documents library g Folibis
Bl Desktop Includes: 2 locations
& Downloads = F = NE b= S A
5| Recent Places FFOutput KSDStore maya
| a Libraries i
|"s| Documents l ' E ' ‘E‘I
J’ Music I 1 1 ' 1
|| Pictures v
- ) microsoft My Adobe Snaglt Catalog
B videos 7 Caotivate ol
File name: m -
Save as type: [CG-SOO Project Files (*.vtprj) v]
“ Hide Folders [ Save ] [ Cancel ]
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In the Save as window set path, enter file name and select file save type then click the “Save”

button to see the following dialog.

Click the “OK” button, you can open the path and the following will appear.

Export Layout to AVI Animation

Click Export button under the File menu, select "Export current layout to AVI animation" from the
drop-down list. The animation export window is as shown below:

w Export Movie

Output Mode

Top
Left
xesolution

Width
Subheadi

( Codec

() Online(SuperFine)
() Online(Fine) Qo
@ Online(Standard)

7 Offline Max size min

() Custom

OK ] [ Cancel

For specific setting methods of export layout to AVI animation, please refer to "Export Current
Layout to Animation" chapter.

Datavideo Technologies Co., Ltd. 166



Example

Create Title

HEADING

¥Subheading

1. Text

1) Enter the text "Heading" font size 32, and "SubHeading" font size 29.

Method 1: In the Object Menu Bar press , click on the Edit Screen, then enter text.

Method 2: in the Text properties tab, click on button
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HEADING|

Method 3: in the Text properties tab, click button

Open saved file
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B

My Recent
Documents

b g Documents

@

by Computer

&

ky Metwark,

Look in: | (3 VisTile

€] j‘ -

) background
() Mwiaker
[ plugin
E]preset

[ 5wsLib

File name: |Texd

v

[ Open J

Files of type; |[I]l][*.t:<t]

o

I_ Cancel ]

After text appears in the tab, click on - button

. E

Lnkitled®

EADIMNG

Method 4: use System paste
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Copy text from desired location

B Text - Notepad
File Edit Format Wiew Help

SuEEeaE"l ng Unda

Cut

Delete

Select Al

In Object Menu Bar click “Text” button, right-click and paste, or type Ctrl+V to paste.

w Alpha Only

show Fill Color

35T

2) Color
Method 1: edit color in the Shader tab
Select "HEADING", click Shader tab, set Gradient as Linear, 90 degrees angle.
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Add a Gradient point, choose RGB style, and set gradient points to (255, 215, 0, 255), (255,
128, 0, 255), (130, 0, 0, 255),

B

Pure Caolor

Face

AN | =11
Ol AAICQH

Gradient

HEADINCGS
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Choose "SubHeading", enter Shader tab, set RGBA to (232, 232, 232, 255),

Pure Color

Face

EEe

]

Subheading

Add Shadow, set width to 5, angle to 45, blur to 3, RGB style, RGBA to (0, 0, 0, 128),
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Subheading

Method 2: Double-click on the text and select shader from library.
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Pure Color
Fac

Linear v

Method 3: Open Shader Template Library, open Single Color catalogue, choose shader 020.

Shader Style

2. Liner

1) Create liner
Use Object Menu Bar to create a rectangle on the Edit Screen
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2) Setshader

Select object, in ﬁ tab choose Gradient-Linear, angle 90, add a Gradient Point, RGB

style, RGBA parameters at (255,215,0,255), (255,128, 0,255), (130,0,0, 255),

Colour

Gradient
*J.
Ay EERT

Use the same method to create another rectangle

3) Set text and object level
As the text was created before the object, the object will cover the text.
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from “Level” -

Method 1: Select text, in Edit Menu Bar choose Move Top

button, or type Ctrl+Home.

Star
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3. Make Group

Method 1: select all objects in Edit Scree, then click on E in Edit Menu Bar, or type
Ctrl+G.

Method 2: Select all objects, right-click then choose “Make Group” from context menu

4. Fade In/Out Animation

1) Click “Effect Edit Mode” to activate 3D editor.

HEAD INR S

Stubhead i ng

00:00:00:00

B | oo Qi

2) CIick to open Effect tab, activate Transparency Keyframe, set transparency to

0, open group in Timeline.
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Double-click expand 3DTransform track and choose "Transparency".
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u Group
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4) Move Timeline marker to 3 seconds, then click “Add/Delet Keyframe” (<}

Add/Remove KeyFrame
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5) Move Timeline marker to Choice “End” -

6) Press - button to see Fade In/Out effects.
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5. Preview

Subheading

Create Effect Title

HEADING

Subheading

1. Text

1) Enter Text

CIick, enter "HEADING" font size 20, and "Subheading"font size 37.

HEADING

Subheading

2) Shader
In Shader tab set to RGB style, RGBA parameters at (230,230,230,255)
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Fure Color

Face

EEBle A

=

2. Liner

1) Create liner and shader
1. Green Rectangle: in Edit Screen create rectangle, open Shader tab, set to RGB, RGBA
parameters to (23,87,91,255)

2. Orange Rectangle: create rectangle, open Shader tab, set to RGB, RGBA parameters to
(255,123,0,255)
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G IGEE

3. Red Gradient Rectangle: copy-paste orange rectangle, extend length, open shader tab,
set Gradient to Linear, add a Gradient Point, set to RGB, RGBA parameters to (41,0, O,
255),(160,22,1,255) (85,0,0,255)

ire Color

EEe
|

Linear §

4. Adjust objects' position and size

2) Adjust text-object levels so all text is placed on top of the objects.
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HEADIMNG

subheading

HEADING

Subheading

3. Make Group

1) Select both texts using the Ctrl key, right-click and choose "Make Group" from context
menu.

FEADING]

ISubHﬂ

2) Use same method to Group all rectangles.The Timeline now has two groups.
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00:00:03:00

3) Double-click to edit group names

13:00 00:0(

00:00:00:00

00:00:00:00 00:00:01:00 00:00:02:00 00:00:03:00 0o:0

Liner

Text Group

4. Create Effect Animation

1) Add Effect

Click on object group, open Effect tab, choose 2D Pan, then click on
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Duration ¢

2) Set Keyframe
1. Set 2D Pan direction as Left to Right

HeelA

Leftto Right

100

2. Activate effect in Timeline [, set percent to 0 at In point
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HEle R

J
inl B

Rightto Left v
Left to Right

Bottom to Top

Left top to Right bottom
Right top to left bottom
Left bottom to Right top
Right bottom to left top

5. Activate animation, in Effect tab set percentage to 0 at In point
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6. Set percentage to 100 at 1 second

EBele laA

.

Rightto Left

Percent

7. In the Edit Screen choose both groups, right-click and choose “Make Group” from
context menu

HEADING

8. Hold Shift, drag Group End to 5 seconds on the Timeline

0:04.00 00:00
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00:00:04:00 e
00:00:01:00

w_'~m\_:;_\

9. Set Timeline marker at 4 seconds, right-click on the track shown below, from
context menu choose "Add Area"

10. Right-click on the track shown, then choose "Play as Child"

3D Transform
Liner

Group

12. Adjust effect position and duration
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Group
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5. Preview

HEADING HEADING HEADING

Subhe Subhead Subheading
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Create Button

1. Draw Circle

-~
4

1) From the “Object” Menu Bar, create a circle by holding Ctrl.

File Edit |Object| Option

j_E"i[:E-EE
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2) Set Shader: Gradient to Linear, 90 degrees, add Gradient Point, RGB, RGBA parameters
to (218,83,20,255),(243,181,100,255),(224,182,74,255)

add @ & e

. O

Gradient | GuadGiid | BmpGrad

Hj ‘- Linear «
S

ngle 40

3) Add Edge: Width 9, Gradient to Linear, 90 degrees, both Gradient Point RGBA
parameters set to (255,255,255,255),(55,54,54,255)
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HEea

2. Draw Reflection

1) Using the “Object” Menu Bar, create a large oval-shaped circle,
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2) Set Shader: Gradient to Linear, 90 degrees, both Gradient Point RGBA parameters to
(255,255,255,205),(255,255,255,0),

& R

Gradient

‘A AH -

R

3) Using the “Object” Menu Bar, create a small oval-shaped circle,
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4) Set Shader: Gradient to Linear, 90 degrees, both Gradient Point RGBA parameters to
(255,255,155,182),(255,255,255,19),

TS TR B T®

Pure Colar

\ ! Face
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Create Custom Shape

1. Draw Leaf

Under the “Object” Menu Bar, use the Bezier Curve tools to draw the following lines,

to start drawing

—
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2. Draw Apple
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3. Shader

1) Make Group

Datavideo Technologies Co., Ltd.

Delete

‘ Locked

Set Start
v Enabled
v Combine Move

Line With Pre Node
Line With Next Node

: v Closed
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Locked
¥ Visible Shift + ¥

Cut Ctrl + X
Copy Ctrl + C

System Paste Ctrl + Shift + V
Delete Delete

2) Set Shader: Gradient to Linear, 90 degrees, RGB, both Gradient Point RGBA parameters
set to (96,201,21,255),(0,23,0,255)

Gradient

3) Set Concave effect: Raise mode, Brightness 100, Blur level 2, 45 degree angle, Height 4.
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Pure Color

Face

Count 1 Angle

> Texture

LinearSheen

BitmapSheen

BumpBitmap
V' Concave
Mode Raise
Bright
Blur &

Angle "

Height &

| Bevel

Create Play by Character

1. Enter Text and Shader

1) Using the “Object” Menu Bar “Text” button, enter "Play By Letter", font size 64, and

press C to center.
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?rréy By: LetterE

Press C key to center

2) Shader: from the shader template library double-click on style 039.

ubTitle | Shader Style | 3D Tr
023 024 25

A\ LY/

o] B " !
Play By Letters
y By

2. Add Area

1) Expand text track, drag timeline marker to 1 second, right-click on the Text track,
choose “Add Area”. In first area, right-click and choose “Play by Character (In)”.
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2) Drag timeline marker to 2 seconds, right-click and choose “Add Area”. In last area
right-click and choose “Play by Character (Out)”
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TTT 1.0000 ()

3) Set play area Frequency: press @ to set 0.2 In/Out frequency values.

TTT 10000 ()

3. Set Keyframe in 3D Transform

1) Drag timeline marker to start position, open Effect tab, set Translate XYZ positions to 64,
-74, 0.
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2) Place timeline marker at Play by Character (In) Out-Point, set Translate to 0, 0, O

3) Set timeline marker at Play by Character (Out) In-Point, click Add Keyframe,
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4) Set timeline marker at Play by Character (Out) Out-Point, set Translate to -64, 74, 0
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4. Preview

Play By Letter

ay By Lette

Create Play by Line

Plav by line
Play by line

Play by line
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1. Enter Text and Shader

1) Write "Play by line" three times on three different lines, size 40, press C to centre.

Play by line

Play by lin
lPIay by Iine‘

2) Shader: apply shader 020 from the templates library

Shader Style
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Play by line

lay by lines
D|g\/ HV HaT=)

2. Add area

1) Extend duration to 6 seconds,

P A3-00:00:00

Play by line '

P 000000

F'Ja' b' line

P A-00:00:00

F'Ja' b' line

Datavideo Technologies Co., Ltd.

00:00:05:00

00:00:05:00

An-Nn-NE-NN
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2) Expand tracks, drag timeline marker to 2 seconds, right-click to add area, right-click

again to set as Play by Line (In),

Text
» & 20 Transf... v Enable Area

Add Area

Play by char (in
Flay by char (out

Flay by line (in

line
T
v Enable Area

oy line (In

oy line (out

= 1.0000 (B

3) Set timeline marker at 4 seconds, right-click to add area, right-click again to set as Play
by Line (Out),
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| 2 .'_‘j -0 ] 00:00:05:00

FJa b"ljne

= 1.0000 {¥) T

F'J-a" b" line

= 1.0000 (¥ T

char (in
out
oy line (in

oy line (out

» S:ljl:u:l;' 0-00 00:-00-05:00

F'Ja' b" line

— 1.0000 ) T =0 1.0000 ()

4) Set play area Frequency: press @ to set 0.5 In/Out frequency values Set 0.5
frequency,
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1.0000 (B

F'J;a" b" line

i 0.5000 (B T 0 1.0000 09

3. Set Keyframe in 3D Transform

1) Drag timeline marker to start position, open Effect tab, set translate XYZ positions to 0O,
-80, 0,

| _ 4 3:00:00:00

F'Ja" tr' line

— 0.5000 () T — 05000 ()
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EE e EH

2)

y line
0.5000 (k) T 0.5000 (k)

ERARCH

3)

i ling
0.5000 () T = 0.5000 ()
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[ENIRCN

(=)

® ® (A

@ @ @

4) Set timeline marker at Play by Line (Out) Out-Point, set Translate to 0, 80, 0.

|2 :_‘j “00:00:00 00:00:05:0C

F'Ja" b" line |

= 0.5000 () oy =0 0.5000 (&)

@ ® &

B @

il

4. Preview

Plav hy

) Plav hv line

Play by line

Plav bv lina Plav bv line
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Dlg\f I"\'lu |:hg

Plav hv line
Dlg\f I"\\J Mal=

Create Mixed Play by Character/Line

1. Enter Text and Shader

1) Using the “Object” Menu Bar “Text” button, enter "Play by Character", font size 48, and
press C to center.
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'Play by Character
Llay by Eharacter

_Play by C_:haracter;

2) Shader: apply shader 013 from the templates library.

Shader Style  2C

= ' Custom

2. Add area

1) Extend duration to 6 seconds,

Datavideo Technologies Co., Ltd. 220



F'J-a" b" Character

F'Ja" tr' Character

2) From 0 to 2 seconds, add Play by Character area, frequency value 0.5,

2 f_‘:l -00:0Q:00 00:00:05:00

Flay by Character
TTT 05000 (& Y

3) From 4 to 6 seconds, add Play by Line area, frequency value 0.5.

| 4 .'_1] -00:00:00 00-00-05:00

O]

3. Set Keyframe in 3D Transform

1) Open Effect tab, at 0 seconds toggle XY scale keyframe to 100 each.
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W Character
e 0.5000 (¥ T 0.5000 ()

Qg e |
B
L4 el

2) At 1second set XY scale keyframe to 200 each.

3)

Character
0.5000 (&
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4) At 4 seconds, frame 20, set XY scale to current keyframe,

5) At 5 seconds, frame 10, set XY scale to 200 each,
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6) At 6 seconds, set XY scale to 0 each.

4. Preview
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gy Ny f ‘haracter

Flay hy (. haracter

Create Advanced Animation Keyframe

Raindrops Animation

1. Create Cloud

1) Use “Object” Menu Bar to create circles and a round rectangle
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Create circles

Create round rectangle

2) Create Boolean Union E,

Place shapes together

M
B

cBoolean Union(Ctrl + ' +)

(g

Apply Boolean Union

3) Set Shader: Gradient to Linear, RGB, RGBA parameters at (210,210,210,255),
(152,152,152,255), 90 degrees.
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[ E e &

Gradient | QuadGrad | BmpGrac

"~ P ket i
) IS -
A

OuterEdge v [ Bl © H
Hormal -
LS Edge
Grad Normal

Grad Inner Edge
Grad Outer Edge
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to add cloud reflection. Set reflection: Single color, RGB,
RGBA parameters at (210,210,210,120)

4) Use “Bezier Curves”

Use Bezier Curve to draw shape

Pure Color

Face

Y V Face

N/ Colour

Color | Gradient

» ™ Texiure

» M LinearSheen
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Cloud reflection applied

2. Create Raindrop

1) Use Bezier Curve to draw raindrop

Use Bezier Curve to draw shape

2) Set Shader: Gradient to Linear, 90 degrees, XY axis to (62, 89), RGB, RGBA parameters at
(110,181,227,255), (12,105,175,255).
Add Edge, set to Outer Edge, Width 3, Blur 0, RGBA parameters at (220,220,220,255)
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Pure Calor .
Face Face
Outline

Add Ec

¥ V Face ( ¥ V Outline OuterEdge v [ H © M

= - Vidth| 3 Normal
e Widtt
Colour Inner Edge

Grad Normal

Grad Inner Edge
Grad Outer Edge

LinearSheen

3. Set Raindrop Animation Keyframe

1) Reduce raindrop play time, from 4 seconds to 1 second

00:00:00:00 ~ A L. 13
00:00:00:00 00:00:01:00

Drag du
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00:00:00:00

2) At 0 seconds, activate 3D Transfrom Translate (0,5,0), XY scale (0,0), and Transparency
(100) keyframes.

3) Drag timeline marker to frame 15, then set Translate (0,0,0), XY scale (100,100), and
Transparency (add current) keyframes.
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4. Preview

Create Progress Bar

Datavideo Technologies Co., Ltd. 233



1. Liner

2. Color

1) Select the progress bar high-light, select gradient, 90 degrees, with the RGBA values at
(188,188,188,200), (255, 255, 255, 0).

J e

BN  RGB| HSB

Count 1  Angle 90
> Texture

> Linearsheen

2) Select the progress bar, select gradient, set RGBA values at (125,34,0,255),
(208,181,172,255), and adjust gradient position to 17.
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HE S
7 |

3. Merge progress bar and high-light

1) Click on create group, then name group

2) Create Animation: select the group, choose template Wipe001. Click to add special

effects such as equal length, feather level 2.
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ElfBG

Elen
gyl

* » du000n00  oooooioo oo

4. Percentage Animation

1) Select the numbers tool, set size tol7, RGBA to (232,232,232,255)

Datavideo Technologies Co., Ltd. 236



2) Set digital animation: Check the key frame interpolation, start value 0, end value 100,

the display format to percentages.

Start Value

End Value v nterpolation
Decimals

MinimumDi...

Display For__.

Thousand arator
Front Lable

Back Lable

Lan je English

5. Preview Animation
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Create Roll Up

Please consult the chapter "Create Roll" for instructions.

Create Crawl

1. Crawl Left

2. Create Text

Enter text in Text tab

Ls woul look around this room tonight

Click on “One Line Text” to create in Edit Screen
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around this room |

As you look around this

3. Set Parameters

1) Use the ruler (Tab key) to set roll area

400 500 GO0 v

As you look around thi

2) Set background area

Datavideo Technologies Co., Ltd.

r ool

Head Pos

End CutOut +
00:00:01:00

Tail Pos

Total Time ~ 00:00:04:00

ool

Liner

Ruler

Bottom

Head Fade Piy Tail Fade Pixe
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a00 B00 o Ton

Head Pos

End Cutout 5

Total Time ~ 00:00:04:00
Loop
Speed dow

W Liner

As you look

Top 415 Bottom

ScrollArea Ruler Full
Left 115 Right
Top 416 Bottom

00:00:03:10 00:00:03:15

1) Example

As you look around t

Render Image

1. Create Image

In the Object menu bar press the button E

Drag cursor then release.
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@ lease choose image file oiffhe-rigis property panel

Select image file in Property tab.

3D Stereoscopic Image
File Name: Bri
Height: 1680 Width: 1050 Crigin
Left: Right:

Clip
Top: % Botto...

Mask Blur

Whole Transparenc

2. Set Parameters
Check “Use ShaderStyle to Render” and use “Bright Channel” as Alpha channel. Enable
“Always Use Image Color as Face Color” and “Binarization” and set Threshold value.
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haderStyle to Render

Bright Channel ¥ | Agit's Alpha Channel

Color as Face Color

v Binarization Threshold

3. Add Face, Outline, Shadow
Add Outline
Click the “Add” button to add an outline in Shader tab.

Set color and width, Blur value as 4, 0.
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Cutline

¥ o Outline

Nidth
¥ Colour
Color

*
-

Add Depth
Click the “Add” button to add a depth.

Cutline

¥ o Outline

Nidth | 4
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Select Gradient and set width, angle as 24, 59.

Cutline

Depth

¥ ' Depth Mormal

Nidth| 24
Colour

Gradient

Linear »

Add Shadow
Click the “Add” button to add a shadow.

Outline

Depth

= v Outline
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Set width, angle and Blur value as 0, 45 and 8.

Cutline
Depth
Shadow

4. Preview
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Create Crawl with Liner

Crawl

1. Create text
Click on the “Object” toolbar and select “Text” button. Then left click in Edit Screen, enter “Crawl
text”

Then left click in Edit Screen, enter “Crawl text”. Set font size as 68

?S'rav\zl texts

2. Setshader
In Shader tab, choose color and set shader parameters
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#"r vvl (=) XL‘
@

3. Set CG properties
Select the text then in CG property tab set Object Type as Text Crawler Object and ID Class as
Crawl Text.
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Direction

Set other parameters shown above.

Liner

1. Create rectangle
Click on the “Object” toolbar and select “Rect” button. Then create a rectangle as the liner of
crawl text in Edit Screen.

&,,vf rl‘v\/l LEAL

2. Shader
In Shader tab, set shader parameters
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Pure Color

Face

3. Set CG properties
Select the rectangle then in CG property tab set Object Type as Universal Flip Object and ID Class
as Play Position
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Edit Crawl Group

1. Make group
Select text object and rectangle object and press C to center. Make text object up.
Press Ctrl+G or right-click and choose “Make Group” from context menu.

2. Set CG properties

Click group object. In CG Tab set Object Type as Text Crawler Object and ID Class as Crawl Text.
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3. Import text
Select Single Line Text File data source.

Click the “Browse” button to import text file and set loop parameters.
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apping option

4. Preview

Press F5 to preview

lding on your rope Got me ten feet off the groundl'm hea
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Create Flip Stock

Stock Price Goup Group

1. Create Text
Click on the “Object” toolbar and select “Text” button

Use the same method to create two text objects stock price and stock change.

2. Crete Liner
Click on the “Object” toolbar and select “Rect” button. Then create a rectangle as the liner in Edit
Screen.

name 10.000 10.00%

Shader

In Shader tab set parameters
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% @

Pure Color

Face

name 10.000 10.00%

Create a rectangle again and set shader parameters

name 10.000 10.00%

In Edit Screen select all objects, set align mode and objects level. Then press Ctrl+G to make
group.
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name 10000 10.00% 3

3. Set CG properties
Hold Ctrl and select “name” and set CG properties in CG property tab.

Use the same method to set CG property foe stock price object and stock change object.

[0y pPLock Frice

ceable Object

Price Goup Group

[0 prock Price Goup Group

Stock Price Drop Group

Use same method to make the stock price drop group. Or copy stock price group then change
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properties parameters.
Set CG parameters for stock price drop group object

LOCE, FFICe LIrop Lafaudp

name 10.000

name 10.000

Stock Price Stop Group

Use same method to make the stock price stop group. Or copy stock price group then change
properties parameters.
Set CG parameters for stock price stop group object,
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name 10.000 " 10.00%

name 10.000 "10.00%
name 10.000  10.00%

Edit Stock Flip Group

1. Make Group
Select three groups then press C. Press Ctrl+G to make group.

i name 10:7000- 10.00%

2. Set CG property
In CG Tab set Object Type as “Stock Flip Object”

1

Stock Flip Object

3. Import stock data

Set data source file as “CSV File”. Click “Browse” button to choose file.
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Has play title text

Preview

Press F5 to preview

Software 7.00 10.06%

7.59

Create Crawl Stock

1. Create Stock Price Goup Group
1) Create triangle
Click on the “Object” toolbar and select “Trianglet” button. Then create a triangle in Edit Screen.
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Shader

In Shader tab set parameters
®

Pure Color

Face

¥ ' Face
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2) Create text
Click on the “Object” toolbar and select “Text” button

Then left click in Edit Screen and enter “name” and set font size as 29.

Use the same method to create two text objects stock price and stock change.

name ;1 0.000 .;_fflﬂ_f‘.ﬂ% E

Shader

In Shader tab set stock object color and stock change color same with the triangle color

3) Set CG property

Select stock name text. In CG property tab set Object Type and ID Class as “Replaceable Object”
and “Stock Name”.
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In Edit Screen select all objects, set align mode and objects level. Then press Ctrl+G to make
group.

Group”

2. Create Stock Price Drop Group

Use same method to make the stock price drop group. Or copy stock price goup group then
change properties parameters.
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Set CG parameters for stock price drop group object

3. Create Stock Price Stop Group

Use same method to make the stock price stop group. Or copy stock price goup group then
change properties parameters.

Set CG parameters for stock price stop group object

Select three groups then press C to centre.
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4, Create Crawl Position

Click on the “Object” toolbar and select “Rect” button. Then create a rectangle.

Shader
In Shader Tab double-click on shader style Color0023
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Select all objects, set align mode and objects level. Then press Ctrl+G to make group.

Set data source file as “CSV File”. Click “Browse” button to choose file
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Software

Marine

Using 3ds max animation in CG-500

1. Set Frame Rate and Time

1) Click “Time Configuration” E":'
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J’Jlillslslll|S|p|1|Iagl|||;p||||;5||||a!0||||al§|!||9|p||||9k|l||160 >
x;|-31.505 Y:|3.7es zjon |Grid=1QD o AutoKeyISelected v] e[ [B] e | Q GE F A

[ Add Time Tag SetKey| J¥,  KeyFiters.. | Wif0 @? 99 - B

2) In"Frame Rate" select PAL, and in "Animation" enter End Time (25 frames equals 1
second).Click on “OK”.

ITime Configuration

—Frame Rate————— 1~ Time Digplay———
i

© NTSC € Fim P e —

- —
@ ¢ Custom il Cancel

" FRAME:TICKS

30 %] £ MM:55:TICKS

— Plavback
[V FealTime W ActiveViewport Only W Loop

Speed: £ s & 1/2¢ & 1y 20 O 4y
Direction: & Fopyard  Feverse § Ping-Pong

—Animation

Start Time:[0 4 Length: [33 =

End Time:l 100 = lI Frame EDunt:IBd ﬂ

Re-scale Time | Cument Time:l 0 ﬂ

—k.ey Stepz
v Usze TrackEar

¥ Selected Ohjects Only W Use Cument Transfonm
¥ Position W Rotation W Scale

2. Choose Field Order

1) From the Menu Bar click Customize, Preferences
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© Untitled — Autodesk 3ds Max 8 — Stand-alone License

File Edit Tools Group Views Create Modifiers Character reactor Animation Graph Editors ﬁenderin !ﬂAXScrip! Help
v Al = H tomize User Interface...

“P’%I%'ﬁﬁ 4l S

— Load Custom UL Scheme

Save Custom UL Scheme
Revert to Startup Layout

Top

Custom UL and Defaults Switcher...

Show UL

v Lock UL Layout

Configure User Paths...
Configure System Paths...
Units Setup...

Grid and Snap Settings...
Yiewport Configuration...

Plug-in Manager. ..

LSO B[=EDE B

2) Open Rendering tab, in Field Order choose Even, click “OK”.

Preference Settings

Inverse Kinematics | Gizmos | MaXScript | mental ray '
General Fles | Viewpots |  GammaandLUT Animation |
~Video Color Check Output Dithering

@ Flag with black ¢ NTSC
¢ Scale Luma ® PAL
¢ Scale Saturation

¥V True Color

— Super Black pot/Fallol Background
: N Angle . Don't Antialias Against
Taeena [15 (24 Separation: 20 2| | | | Backgiound
~ Default Ambient Light Color— — Output File Sequencing—— r Filter Background
_ I Nth Serial Numbering I~ Use Environment Alpha
— Render Termination Alert

[~ Beep Frequency: |440 EJ Duration: |200 ﬂmilliseconds
I~ PlaySound File: Choose Sound... |

— GBuffer Layers Bitmap Pager
Maximum Number: [0 3| [~ On

Page Size (kB): [T22 3]
plitieaiy Bitmap Size Thieshold (kB [Z0357 3
M On tMemory Pool [kB): | 50000 _:J

Cancel

3. Render Setting

=
1) Click “Render Scene” ﬂ
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z Customize I!M Help

* € o o | Bl R AS= = .

2) Open Common tab, set Range, Output Size, and activate Render to Fields.

@ Render Scene: Default Scanli...

Render Elements | Raytracer | ‘Advanced Lighting |
Common | Renderer |

¢ Frames ]1,3,5-12

[Custom < hpertue Widthimn}: [355 4]

Width: [B0 2| | 320s240 | 720nd86 |

Height: 80 w2 640:480 | GOOxE00 |
Image Aspect 1333 =B Pixel dspect: [T0 3|8
rosions- R AEler-ci Si

[V Atmospherics Render Hidden Geometry

IV Effects [~ Area Lights/Shadows as Points

[V Displacement [ Force 2-Sided
|— Vldeo Color Check o Super Black

vV Use Advanced nghtmg"

™ Compute &dvanced Lighting when Fiequired'
@ Production Preset:

¢ ActiveShade Viewport: lTop I _I Render I

Datavideo Technologies Co., Ltd. 268



4. Save Setting

1) Inthe Render Scene dialog window, click “Files” under Render Output.

@) Render Scene: Default Scanli... EFE@

Render Elements I Raytracer | Advanced Lighting |

Common | Renderer |

-

[V Atmospherics I Render Hidden Geometry

[V Effects I Area Lights/Shadows as Points
[V Displacement [~ Force 2-Sided

I~ Video Color Check |~ Super Black

[V Render to Fields

~Advanced Lighting
[V Use Advanced Lighting
|~ Compute Advanced Lighting when Redgi

— Render Output
I~ SaveFile

[~ PutImage File List(s) in Output Path(s) Create Now
@ Autodesk ME Image Sequence File [.imsq)
¢ Legacy 3ds max Image File List [.ifl]

I~ UseDevice | Devices...

IV Rendered Frame \Window | Net Render
I~ Skip Existing Images

[+ Email Notifications |i
I+ Scripts |
[+ Assign Renderer li

# Production Preset: v

¢ ActiveShade Viewpor!zITop vI _BJ Render

2) In Save As, enter Render Output File name, save as Targa Image File. (Here, .tga files

are used, but .jpg, .png files can also be used).
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Render Output File

Histary: IE:'\F'rogram Fileghimages j

Save jn: ILf} imanes ﬂ =% Ef-

Set save file location

/Enter name

File harne: ’E#/

Save az type: | Targa Image File [*tga.” vda  ich. " vat] j Cancel ‘
JPEG File [*.jpa.” jpe.”. ipea) -
) PHG Image File [* pno)

Devices. | 1MoV QuickTime File [ mov)

SGl's Image File Format [* rgb,”. 2ai)

Setup.. RL4 Image File [*1la]
BEE lmage Fils [* IMAGE
Ifa... nage
mage File M
Wi DOS Image Filg'[*. ddz] =
ﬁ Al Files [7] v
Statistics: M/ ”

Locatior: N/ Choose .tga format

3) Infollowing dialog window set Image Attributes to 32 Bits-Per-Pixel, and activate
Compress. Click “OK”.

Targa Image Control [5_(|
— Image Attributes
1B | Compress
BitsPerFizel + 24 ™ Alpha Split

™ Pre-tultipiied Alpha

— Additional Infarmation

Authar Marme: | Job MameslD: |

Comrments: |

5. Render Animation

In the Render dialog window, click on “Render” button.
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© Render Scene: Default Scanli...

Render Elements | Raytracer | Advanced Lighting
Common l Renderer
[= Common P: 4 |
r~ Time Output
¢ Single Every Nth Frame: [1 =

¢ Active Time Segment: 0To 100
@ Range: [0 2| 10 [T00 =
File Number Base: [0 &

¢ Frames |1,3512

r~ Output Size

IDustnm v|  Aperture Widthmm}: [350 2
Width: I 640 i] 320x240 7202486
Height: I 480 ij 640x480 800600
Image Aspect[1.333 5| 8| PixelAspect [T0 2|8
r Options

IV Atmospherics ™ Render Hidden Geometry

v Effects I~ Area Lights/Shadows as Points
v Displacement I~ Force 2-Sided

I~ Video Color Check [~ Super Black

IV Render to Figlds . . t
~ Advanced Lighting = 4
P Useadvanced Lisninf@ICl@ri ng

™ Compute Advanced Lighting when Required

Total Animation:
HNEN
Current Task: Rendering Image

Pause Cancel

B Common Parameters |:
Rendering Progress:
Frame # 11 Field 1 Last Frame Time: 0:00:00
12 of 101 Total Elapsed Time: 0:00:02
Pass # 11

Time Remaining: 0:00:24

# Production (S0 o v

¢ ActiveShade Viewporl:IPerspective - Ell

6. Change Format

1) Open MV program, click , then select 3ds max Render Output File.

Pixel Ratio

2) Type Ctrl+A to select all, then click “Open”.
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Image Preview Info

Look ir: | ) images

&

My Recent
Documents

=

=

esktop

Select all

My Documents Height:

Format:

.:’] File: name:
Iy Metwark Files of type: |AII Farmnats - | Cancel

V Default

Earth0000

00:00:00:00

3) Set save location

Earth0000
Earth 1
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4) Click “Render” button
Grid Color V Default

Earth0000

Pixel Ratio: 1.00

Criginal HW

Right

Width
ve
Height

Click render |ramerate

7. Usingin CG-500

1) Open CG-500 in the Object Menu Bar click . A frame will appear in the Edit

Screen

2) Inthe Properties Tab, click and open the MV Render Output File.
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MName

0.00

10000 | = 100.00

0.00 4] 0.00

0.00 0.00

C:\Documents and Se

Width: 640 Height:

Length:

Trim In;
Trirn Out:

s sy
Trim Out: Repeat:

Repeat: 1.00

Origin

After Effect Animation in CG-500

1. New Composition and Composition Setting

1) Open After Effects, then choose “Composition”, “New Composition”
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&) Adobe After Effects — Untitled Project.aep

Ctrl+K
Ctrl+Shi£t+B

Set Poster Time

Trim Comp to Work Area

Crop Comp to Region of Intere3

Add to Render Quene \l*PS}fot'fr’

Add Output Module I I e
Preview
Save Frame As E

Make Crl+i

Pre-render..
Save RM Freview

Comp Flowchart ¥iew Ctrl+Shi f1+F11

2) In Composition Settings dialogue window, choose size from Preset drop-down list or set
custom size in Height/Width fields. Set project Duration, then click on “OK”.

Composition Settings

Pixel Aspect Ratio:

Frame Rate:

Resolution: _ 720 x 56, 1.6 MB per Sbpe
Start Timecode: |0:00:00:00 Base 25

|37i1u'ratiéh:'-0100:05:00 Fs 0:00:05:00 Base 25

- , J

Set duration —— ——

2. Render Area

Drag timeline to set render area
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Black Solid 1

3. Render Setting

1) In Menu Bar choose “Composition”, “Make Movie”.

& Adobe After Effects — Untitled Project.aep *

File Edit [OVTITRSCIN Layer Effect Animation View Window Help

New Composition. .. Ctrl+N

Composition Settings. .. Ctrl+kK
Background Coler. .. Ctrl+Shi ft+B
Set Poster Time

Trim Comp to Work Area

Crop Conp to Region of Interest

Add to Render Queue Ctrl+Shift+/
Add Output Moduls

Breview

Ctrl+h

Ctrl+5hi f1+F11

B

2) Open Render Queue tab, click “Best Settings”. Choose Upper Field First from Field
Render drop-down list, then click on “OK”.
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Render Settings

~— Conposition “Conp 1”
Quality: [Best v Proxy Use: | Use No Proxies
Resolution: Effects: | Current Settings

Size: 720 x 576 Solo Switches: | Current Settings

Disk Cache: | Read Only v Guide Layers: | Al Dff

[Juse OpenGL Renderer Color Depth: | Current Settings

 Tine smin;—l_ PE
Frame Blending: | On For Checked Layers © Frane Rate

Field Render: | [RERPSNRVSENIIE @Use conp’ s frame rate (25.00)

OUse this frane rate:

3:2 Pulldown:
Motion Blur: | On For Checked Layers v
Time Span: | Work Area Only v

- Option

All Renders

se storage overflow
Skip existing files (sllows multi-wachine rendering)

Current Render

» Current Render Details

Output Module:

3) Output Module Settings: in Render Queue tab click “Lossless”, then choose Targa

Sequence from Format drop-down list.

Output Nodule Settings

— Based on “Lossless”

Format: | Video For Hindows (v
Fninated GIF
BUP Sequence

= ton: | Cineon Sequence =
Fost-Render Aetion: | )0 CricTnage THAGE cl'ck
FLC/FLT
Filnstrip

Video Output | IFF Sequence
JPEG Sequence
E;

MPEG2

IPEG2-DVD v
auF
OpenEXR Sequence plors ]
PCX Sequence e v
PICT Sequence Matted)
— PUG Sequence
Ostreter Photosliop Seqnencs
Hidth Pixis Seqianse:
Rendering 120 x Qui ckTine Movie
adiance Sequence
Reallledia
Stretch %: x SGI Sequaiice

Embed:

No Compression

Lock Aspect Ratio to §

WAV
Windows Media

—Ocrer
Use Region of Interest Final Size: 720 x 576

Top: E’ Left: D Bottor light: D

[ [JAudio Output

All Renders

Format Options.
Current Render
44,100 Wiz

*» Current Render Details

4)  Click “Format Options” button, set Resolution to 32 bits/pixel. Click on OK.
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OQutput Nodule Settings

Based on “Lossless™
Format: T

Embed:

Post-Render Action: lHonc

Resolution
O 16 bits/piel
() 24 bits/piel

| (%) 32 bits/piel I

[C]RLE Compression

Cancel

v of Inte Final Size: 720 x S76

Left: [0 Bottom: [0 deht: [0 |

—| | #udic Output

Format Options

44. 100 JHz 1€

5) Under Video Output, choose Straight (Unmatted) color to make object edge look

smoother. Click on “OK”.

Output Hodule Settings

— Based on “Lossless”
Format: | Targa Sequence v|
Embed: Froject Link
Fost-Render Action: | Hone v|
_ ¥ideo Output
Startir_}g o Use Comp Frame Humber
Channels: | BGE + Alpha v|
Depth: | Millions of Colorst ~|
| Color: | Straight (Ummatted) v||
_D§tretch
idth
Rendering T20 = ETE
Stretchx Custom
Stretch % i Stretch Quality:  High
Locl Azpect Ratio to 5:4
—[orep
Uze Region of Interest Final Size: 720 x ST
T[] e[ ] mem ] e [
Audio Output
Format Optioms. ..
44,100 lHr 16 Eit Steren
1T oE ) [ Camead |

6) Name file: click “compl1[####].tga” button, set save location and enter file name. Click

on “Save”.
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Output Movi

Savein: | ) New Folder

My Recent
Documerts

My Documents

All Renders

Save localtion

File name:

My Network | Gave as type:

Current Render

T - N S

[ Render Settings: [¥] Ezsed on "Eest Settings” Log:
>  Output Module: [¥] Eased on "Lossless” Output To: [¥] Comp 1 [####4] tga

7) Click on “Render” to start rendering.

4. Change Format

|Ettectsaga

| Targa ["tgm)

Open MV program, import .tga file created in After Effects
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00:00:01:00

5. Using in CG-500

Open CG-500, clickm , a frame will appear on the Edit Screen. In Properties Tab open
MV render output file.

File Edit |Object

YEIE

SETEE I BRI
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WETS

Describe

Position X 409

Rotation 0.00

Scale A 100.00 100.00

Shear ® 0.00 0.00

0.00 0.00
FileMame:
Width: 80 Height:

Length; S50 Field Order:  Upper Field First
Height:

Length: 0 Field Order; per Field First Present;

Trim In:
Present:

Trim Out;
Trimn Ir:

Repeat:

Origin

Combine Animation with CG-500 Animated Header

1. Set Keyframe positions

1) In the Animation Template Library, choose Movie2, "Effects1". Double-click to place in
Edit Screen.
Activate the 3D Edit Mode, and set Effectl Y-axis to 180 (this animation is a flame that
moves from left to right, but here we invert the direction)
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Effects1

2) From the Animation Template Library, choose Moviel, "Redearth". Adjust size and

position.

Redearth

3) Set Redearth keyframes: extend duration to 7 seconds 9 frames, then drag timeline
marker to 0 seconds. In 3D Transform set animation displacement keyframes.
0 seconds: XYZ (95,0,0), 15 frames: XYZ (0,0,0),6 seconds: XYZ (0,0,0),End point: XYZ
(95,0,0)

00:00:07.08 - gl , ) L Y
00:00:00:00  D0:00:01:00  00:00:02:00  00:00:03:00  00:00:04:00 00:00:05:00 00:00:06:00 '00:00:07:0!

Extend duration
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00:00:00:00 00:00:01:00 00:00:02:00 00:00:03:00 00:00:04:00 00:00:05:00 00:00:06:00 00:00:07

{ 00:00:07:08 )

=

= * Movie

00:00:00:00 00:00:01:00 00:00:02:00 00:00:03:00 00:00:04:00 00:00:05:00 000

6 seconds: XYZ (0,0,0)

BEHEEEEREEO

2. Background and Text

1) Use Bezier Curves to draw backgrounds, then insert text.

HEADING

S ——

2) Set upper background color: set to gradient, 99 degree, RGBA (185,125,12,255) and
(152,19,0,255); concave effect RGBA (255,255,255,255).

: EEe A
Colour =

Gradient

fj [ l Linear 5

E

RGB

LinearSheen
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3) Set lower background color: set to gradient, 85 degree, RGBA (218,168,44,255) and

(142,23,6,255); concave effect, RGBA (255,255,255,255).
Y V Face

v Colour

_olor | Gradient

¥ 'V Concave

Mode
Bright
Blur &
Angle

Count 1 Angle

3 Texture Ha 8

Bevel
> LinearSheen
4) Text color: set "HEADING" RGBA to (210,210,210,255), and "Subheading" RGBA to
(0,0,0,255)

Y V Face
y Colour

Color | Grz

5) Choose "HEADING" and background to make group, then set keyframes and duration as
shown below
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00:00:00:00  00:00:0

6) Choose "Subheading" and background to make group, then set keyframes and duration
as shown below
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Out point at 7 seconds 3 frames

At Out point set
displacement to (0,-8,63)
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4. Animation Preview

- \ HEADING
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Operation Flow of Plugins

Operation Flow of Magic Composite

1. Run Magic Composite Plugin
Click on “Object” button in tool bar, then choose “Magic Composite” button from the
drop-down list of “Title Plugin”.

File Edit |Object

Animation

Untitled

2. Create Push Back

Push Laye

1)

Help (F1) Cancel

Release mouse, create a push back object. New pushback object appears in the object layer list.
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Pushback

r

First click to select push in Edit Screen, or in the object layer list click to select. Then click the
“Down” button under object layer list to change object layer order.
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Pushback

4. Bezier Editor
First select a push object, click the “Bezier Editor” button or double click left mouse button,
push, and edit Bezier curve.

4 3 A

5. Preview
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Operation Flow of Text Kerning/Leading Animation

Click the “Horizontal Text” button to create a text object in Edit Screen of CG-500. After creating
object, select “Text Kerning/Leading Animation” from the drop-down list of “Title Plugin” in tool
bar.

File Edit |Object| Option Scroll

nimation

Kerning Animation

1. Set Kerning Animation Mode
Click the “Align Center” button in menu bar to set kerning animation mode.

2. Keyframe Setting
Move timeline to 2 seconds, click the “Add/remove keyframe” button in the timeline
window.
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00:00:02:00

00:00:00:00 00:00:01:00 00:00:02-00

Y

# Tex

Move timeline to 4 seconds in the timeline window then in Property screen set
parameter as 0.

Text Kerning/Leading Animation ([0 [ [4

3. Preview

Text Kerning Animation

IText Kerning Animation
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IText Kerning Animation

Leading Animation

1. Set Leading Animation Mode
Click the “Align Middle” button in menu bar to set leading animation mode.

eading Animation
ing Animation
eading Animation

00:00:00:00

Ti ngll...

2. Keyframe Setting
Move timeline to 0 second, click the “Toggle Animation” button in the timeline window.

00:00:00:00

¥ g Text Kerning/L...

00:00:00:00 00:-00:01:00

Kerning
Leading
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Text Kerning/Leading Animation

Kerning

Leading

100.

-00:

¥ Text Kermning/Leading
[T <] 9[> Kerning

(S <] # [

00:00:03:24

Te ningfL...

3. Preview

| ext Leading Animation
| ext Leading Animation

lext Leading Animation
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I'ext Leading Animation

Iext Leading Animation

lext Leading Animation

I'ext Leading Animation
Text Leading Animation

I'ext Leading Animation

Operation Flow of Image Slide Show

Click on “Object” button in tool bar, then choose “Image Slide Show” button from the drop-down
list of “Title Plugin”.

File Edit |Object] Option Scroll Device

1. Import Images

Click the marked area in the following picture to import images.
Or click ”Import”- to import.
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Picture duration Frame

ation Frame

After choosing images, click the “Open” button.

Image Preview Info

| T | ¢ o &
Look in: l_Q!njlage1 | 0 7 L:2:]
= ~
) '
My Recent
Documents
— |

L

Desktop Image001.bmp Image002.bmp Image003.bmp

J [ — Width: 758
My Documents Height:573

:;)j! Format:BGRA4444
=
: Image004.bmp Image00s.bmp Image006.bmp
My Computer
bt |
e r =1
‘4 File name: |Image002.bmp adl l Open ]
D . ‘ ;
My Network  Files of type: | &ll Formats [*.tga;® vda;"ich:" vst." psd; pdd*1 v | [ Cancel ]

2. SetImage Convert Type
Click “Image Convert Type”, select “Pan & Scan” in the context menu.

Set Size
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1) Clicking the following buttons can quickly alter size, supported common sizes are full
screen, 1/4 and 1/8.

3. Adjust Image Order
Left click chosen image, for example Image004, in the image list. Then click the “Delete”
button to delete the image.
The buttons on the right side of the list from top to bottom: “Add”, “Delete”, “Empty”, “Up”,
“Down”, “Move to Home” and “Move to End”.

Farameters list

Imanali19

4. Set Special Effect
Choose “Custom” in the Effect Option screen. Click “Effect Class”, select “Others” in the
context menu.
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Others
20 Trans
Bli
|oter
Others

Ficture duration
Nipe

Effect duration

31194

Frame

Frame

Click the “Seed” button behind Random Seed.
Set Picture duration and Effect duration numerical values as 75 and 25.

Ficture duration 7! e

Effect duration 25 e

5. Preview

298
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Operation Flow of 2D Stroke Animation

Click on “Object” button in tool bar, then choose “2D Stroke Animation” button from the
drop-down list of “Title Plugin”.

File Edit |Object| ¢

Untitled

LUr-point Letormation

1. Create Stroke Lines
1. Click “PaintStroke” in the tool bar.

2. Left-click in the Edit Screen, drag mouse to create StrokelLine01.

3. Use the same way to create StrokeLine02 and StrokelLine03.
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2. Edit Bezier
Left-click to select a stroke line in the Edit Screen, then double-click, or click “Bezier” in tool
bar.

Drag control points to adjust.

3. Set Properties
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StrokeLin
Strokeline 03

Start Position
End Position

Stay time R_..

Solid Color
Thickness
Fineness
Feather
Opacity

Blend Mode

Set Start Position and End Position
Left click to select a stroke line (for example StrokeLine 01) in the Stroke Lines List panel.
Set Start Position, End Position and Stay Time Ratio value as 0, 100 and 0.

Start Position
End Position

Stay time R_..

Use the same way to set properties parameters for StrokelLine 02 and StrokeLine 03.
Shader
Click the Color button behind Solid Color.

Solid Color

Select color in the Color Select window then click the “OK” button.
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RGB HSH Ve

Note: this operation will change color of all stroke lines.
Set Thickness, Fineness, Feather and Opacity value as 15, 1, 50 and 100.

Thickness

Fineness

4. Logo

1. Click on the “Logo” button to open Logo tab. Enable “Insert Tracing Logo”.
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=

v Insert Tra

2. Click the “Browse” button then select a logo, click the “Open” button.

Open
Look in: [ij Strokelogo V] 3 7 R
- ruuLUdinL Py FENUULPIY FENUUZ Py X
f ¢) il
My Recent 4
Documents ‘
?‘.
@
Desktop
Pen003.png Pen004.png Pen00S.png
My Documents / ‘
My Computer -~
PenNA.nnn PeANN7.nnn PenN&.nnn i
‘b% File name: {Pen004.png ﬁ i Open
¢ \_) ________ TOELE
My Network  Files of type: {AII Formats [*.tga;" vda;” ich;* vst” psd;” pdd;* | » ‘ Cancel
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3. Left click and drag the hot point to set logo hot point position.

4., Set X Scale value, Y Scale value and Rotate value as 70, 70 and O.

5. Preview
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Operation Flow of Image Four-point Deformation

Create an image object in Edit Screen, choose “Image Four-point Deformation” button from the
drop-down list of “Object” in tool bar.

File  Edit |Object| Optio

1.  Click on Pointl in Edit Screen, “Add/Remove Keyframe” button after Pointlx in timeline

window, you can apply and add a keyframe at 0 second position.

Datavideo Technologies Co., Ltd. 305



¢ 00:00:00:00

S T W

= E]

l-] [ l-] [ r] [ r] [ | [:] (10

00:00:01:00

T v &% Im

2. Click on Point2 in Edit Screen, move timeline to 1 second position, then click on
“Add/Remove Keyframe” button after Point2x in timeline window, thus, you can apply and
add a keyframe.

00:00:01:00

¥ & Im

Move timeline to 2 second position, then click on “Add/Remove Keyframe” button to add a

keyframe.
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~
(

aWalal
UU 0L

3.  Click on Point3 in Edit Screen, move timeline to 2 second position, then click on
“Add/Remove Keyframe” button after Point3x in timeline window. Thus, you can apply and
add a keyframe.

AN-NN-ND-
00:00:0L:

Move timeline to 3 second position, then click on “Add/Remove Keyframe” button to add a
keyframe.

o TalalaNarNala
U000:05:00

Set the keyframe value as 20.
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4.  Click on Point4 in Edit Screen, move timeline to 3 second position, then click on
“Add/Remove Keyframe” button after Point4x in timeline window. Thus, you can apply and
add a keyframe.

T T

00:00:03:00

% Im

Move timeline to 4 second position, then click on “Add/Remove Keyframe” button to add a
keyframe.

5. Preview
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OPoint — PPoint2
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Operation Flow of Text Path Animation

1. Create a curve text in Edit Screen of CG-500.

2. After creating, select “Text Path Animation” from the drop-down list of “Title Plugin” in tool
bar.

File Edit |Objec

Untitled

3. Move timeline to 0 second position, click the “Toggle Animation” button in the timeline
window.

00:00:00:00

00:00:00:00 Q00000100 00:00:02:00

In Property tab set parameter as 100.

Text Path Animation

[ % [ Position

4. Move timeline to the tail frame position then click “Add/Remove keyframe” in the timeline
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window.

00:00:03:24

Text Path Ani...

*osition (] <]

Set parameter as -20 in Property tab.

¥ Text Path Animation

(1 <] Pos

00:-00:01:00

5. Preview
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Operation Flow of Shadow

Create an object in Edit Screen, choose “Shadow” button from the drop-down list of “Object” in

tool bar.

File Edit |Object| Option

Untitled

Back Shadow

Click on “Back Shadow” button in Property panel.

(1] # [

(5] <] & [ Blur

(T<]# [ Transp...

Click on the Color button, select a color, then press the “OK” button.
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il

RGB | 'HSB Ve

-

Still Shadow

Step-1 Setting parameters in back shadow properties panel.

Click on “Translation” button in tool bar.
) h I:‘ +

You can also drag control point in editor area to adjust positions in the X and Y axis.
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Step-2 Preview

Dynamic Shadow
Step-1 Adjust timeline to 0 second position, click on the “All Parameters Animating” button.
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00:00:01:20

S T&%B
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Step-4 Preview

Mirror shadow

Click on the “Mirror Shadow” button in the Property panel.
[ 1

Mirror

Blur X
BlurY
m Ra

Still Shadow
Step-1 Setting parameters in mirror shadow properties window.
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Click on “Translation” in tool bar.

You can also drag control point in editor area to adjust positions in the X and Y axis.

Step-2 Preview
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Dynamic Shadow
Step-1 Adjust timeline to 0 second position, click on the “All Parameters Animating” button.

Step-2 Move timeline, then click on the “All Parameters animating” button.

J 1

Mirror Shadow
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Set parameters shown below.
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Step-4 Preview
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Slant Shadow

Click on the “Slant Shadow” button in the Property panel.

Click Color button, select a color, then press “OK” button.
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RGB HSE |,

Still Shadow

Step-1 Setting parameters in slant shadow properties window.

Click on “Translation” in tool bar.

D h I:‘ +

You can also drag control point in editor area to adjust positions in the X and Y axis.
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Click on “Slant” in tool bar.

You can also drag control point in editor area to adjust slant shadow positions in the X and Y axis.

Step-2 Preview

Dynamic Shadow
Step-1 Adjust timeline to 0 second position, click on “All Parameters Animating”.
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Set parameters shown below.
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Set parameters shown below.
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Step-4 Preview.
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Keyboard Shortcuts

Common Shortcuts

F1 -Online Help

Ctrl+Z -Cancel Operation
Ctrl+Shift+Z -Restore Operation

CG-500 Shortcut Keys

File Command | Keyboard Shortcut Remarks

Global

New Document Ctrl +N

Save Document Ctrl +S

Open Document Ctrl +O

Start Project Ctrl+Shift+N

Auto Save As Document Ctrl + Shift +S

CG Preview Play F5

3D Stereo Adjust Ctrl+F4

CG Capture One Frame as EditView | Ctrl+F7

Background

CG Capture Frame F7

Preview in External Monitor Alt+M

CG Clear Output F6

Save Document Animation Alt+S

Edit Alt+E

Export Movie Ctrl+E

Document Settings Ctrl + Shift + P

Hardware Option Ctrl+Shift+H

System Option Ctrl + Shift + O

Tab To Library Ctrl + Tab

Reset Shader Style Ctrl + F10

Reset text Props Ctrl + F9

Reset Ul Ctrl + F8

Scroll Edit Mode F11

template Edit Mode F12

Effect Edit Mode F10

Graphics Edit Mode F9

Edit Only Ul F8

Library F3

About Ctrl+F1
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Layout

Delete Delete

Paste Ctrl +V

Cut Ctrl + X

Copy Ctrl+C

Bottom End

Top Home

Down PageDown

Up PageUp
Timeline

Delete Delete

Ungroup Ctrl +U

Make Group Ctrl + G

Set Objects Duration Ctrl +D

Play/Stop Space

Play/Stop In Out Shift+Space

Objects Trim Out Align End Pos Shift + ]

Objects Trim In Align End Pos Shift + [

Objects Move Align Out Point |

Objects Move Align In Point [

Objects Trim In Align Cur Pos Shift+l

Objects Trim Out Align Cur Pos Shift+0

Objects Trim out Inc.One K

Objects Trim out Dec.One J

Effects Trim out Inc.One Ctrl +K

Effects Trim out Dec.One Ctrl +)

Keyframe Shift Inc.One Shift +.

Keyframe Shift Dec.One Shift +,

Effects Shift Inc.One Ctrl +.

Effects Shift Dec.One Ctrl +,

Objects Shift Inc.One

Objects Shift Dec.One ,

Expand E

Zoom Out Ctrl+Num+

Zoom In Ctrl+Num-

Fit =

Move Bottom Ctrl + Home

Move Top Ctrl + End

Move Down Ctrl + PageUp

Move Up Ctrl + pageDown

Selection Out

Shift + End
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Selection In Shift + Home

Next Key Frame Down

Prev. Key Frame Up

End End

Home Home

Next Frame Right

Prev. Frame Left

Goto Next Mark Point Shift+Page down

Goto Prev. Mark Point Shift+Page up

Goto Out Point w

Goto In Point Q

Clear All Mark Point Alt+Shift+M

Clear In/Out Point X

Clear In Point Alt+l

Clear Out Point Alt+O

Set Mark Point M

Set In Point |

Set Out Point o

Set Pause Point P

Goto Prev. Pause Point Alt+PageUp

Goto Next Pause Point Alt+PageDown

Clear All Pause Point Alt+Shift+P

Select None Esc

Select All Ctrl + A

Edit Alt+E

Visible \"

Lock L

Pause To Shift + vV

Paste New Ctrl+V

Paste All Ctrl + Shift + V

Copy All Shift + C

Cut Ctrl + X

Copy Ctrl+C
EditView

Delete Delete

Play/Stop Space

Center Pivot Ctrl+ M

Quick Text F2

Character Map Alt+T

Guideline G

Ruler Tab

Origin Media Object (o]
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Alpha A

Rotate R

Scale S

Translate T

Motion

Mix Penetrate Shift+T
Mix Normal Ctrl+T
Boolean Intersect Shift + -
Boolean Xor Shift + =
Boolean Subtract Ctrl + -
Boolean Union Ctrl +=
Same Ver. Space

Same Hor. Space ,

Align Ver. Shift +\
Align Hor. \

Align Bottom Shift +]
Align Top Shift +[
Align Right 1

Align Left [

Hor. Screen Center H

Ver. Screen Center Vv

Screen Center C

Full Screen F

Move Bottom Ctrl + End
Move Top Ctrl + Home
Move Down Ctrl +Pagedown
Move Up Ctrl + PageUp
Zoom Out Ctrl + Num+
Zoom In Ctrl + Num-
Actual Size Ctrl+0

Fit =

Select None Esc

Select All Ctrl + A

Cut Ctrl + X
Paste Ctrl +V
Copy Ctrl +C
Make Path Group Ctrl +P
Next CG Subtitle Line PageDown
Previous CG Subtitle Line PageUp
Ungroup Ctrl+ U
Make Group Ctrl + G
Visible Shift + vV
Lock L
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Some Questions and the Answers

How to Change Parameter Value

Parameter Type 1

To set parameters:

Method 1: move cursor over the field and left click then enter numbers.

Method 2: move cursor over the field then press the left mouse button and drag right or left.
Parameter Type 2

Colour

Gradient | Quad Grad

To set parameters:
Method 1: move cursor over the field and left click then enter numbers.

Method 2: move cursor over the field then press the left mouse button and drag right or left.
Method 3: move cursor over the field then click on “<, >“
Parameter Type 3
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Width

Strength

Set parameters by:

Method 1: Dragging the slide marked in green in the image above
Method 2: please refer to Parameter Type 2 about other methods.
Parameter Type 4

Start Fade in Effect Time { 00:00:01:00
Stay Time  00:00:01:00
Head Fos ]

End Fade Out * Effect Time  00:00:01:00
Stay Time  00:00:01:00

Tail Pos 1080

Set parameters by:
Method 1: moving cursor over the field then click on “<, >
Method 2: Dragging the cursor over the field.

Method 3: moving cursor over the field and left click then enter numbers.

How to Enter Special Characters

You can enter special characters for text object, curve object and morph object.

To enter special characters:

1. After creating a text object, right click in text and choose" Character Map” from the context
menu or press Alt+T.

Ak

Character Map

2. Each font type has the corresponding characters in Character Map window. Select a font then
click the desired character in the Character Map window.
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Agency FB
ALGERIAN

Arial Baltic
rial Black
Arial CE

o Character Map

Arial Narrow
Arial Rounded M

How to Convert Character Case

You can convert lower case to upper case by using the Small Caps.
1. Click to select text.

2. Click the “Hide/Show Font AdvProps” button in tool bar then set Small Caps value as 60.
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How to Scale Shader Style Parameter

By using the Scale ShaderStyle Parameter, you can scale all shader parameters of Face, Outline,
Shadow, etc. simultaneously.
1. Click the selected object including face, outline and so on.
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o Quiline

Jidth

¥ Sl

2. Right click the object then select “Scale ShaderStyle Parameter” from the context menu.

Set Scale Factor parameter in the Scale ShaderStyle Parameter window. The maximum is 200 and
minimum is -200. You must convert the value to percentage, thus the shader parameter value will
triple or reduce twice at most.

Set Scale Factor parameter as 200 then click the “OK” button.
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» W Face

v Outline

MNidth
¥ ' Shadow
Midth
Colour
Image
LinearSheen

BitmapSheen

Example:

Scale Object Data When Video Resolution Is Changed

1. Click the “System Option” button in state bar, the System Option window will appear. Then
select “Default Setting” to open the Default Setting panel.
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Jround Settin

Default Fade InfOut Percent: 10

Default Obj gth: 100 Frame

U need to res

Default all oK Cance Default

2. Check “Scale Object Data when video resolution is changed” and change the Scale Object
Data Control Factor parameter value.
3. Click the “Apply” button and then restart CG-500 to apply the change.

How to Hotkey Process Special Language

After launching CG-500, you can press F4 to switch current font settings with the special language
font settings.

To set special language font settings:
1. Click the “System Option” button in state bar, the System Option window will appear.
2. Then select “Text Setting” to open the Text Setting panel.

3. Select font settings in the panel.
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ing

Default Input String:

T [T B S
T:a TI:-

Verical text

* To apply these cha you need to

Default all C : Default

Change Arrangement of Timeline Clips

Clip arrangement on timeline is different due to different softwares. For those used to clip
arrangement on timeline in After Effects, you can custom clip arrangement on timeline in VisTitle.
Right click at the head of all tracks to enable or close “Track Layer Matched with Object Layer”
option. The position of objects in editing area won’t change as the option changes.

w Timeline Pointer
Timeline Auto Snap
xpand all Track

Zoom Fit

Track Layer matched with Ob

Keyframe Position Autom

Objects arrangement and layers are shown as below. Text A, B, C, D correspond to the creating
orderas A, B, C, D.
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The following pictures are with the clip arrangement on timeline off and on. Close “Track Layer
Matched with Object Layer” option:
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Service & Support I

It is our goal to make owning and using Datavideo products a satisfying experience. Our support staff is available
to assist you to set up and operate your system. Contact your local office for specific support requests. Plus,
please visit www.datavideo.com to access our FAQ section.

Please visit our website for latest manual update.
www.datavideo.com/product/CG-500
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